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Expansion 1 Frame DIP Switch

The switch settings must be verified and set before power is applied to
the BTS. Refer to Figure 5-2 or Table 5-2 for the expansion 1 frame.

Table 5-2: Frame ID Switch Position – Expansion 1 Frame

1 2 3 4

DN UP –– ––

–– = Don’t Care. These switch positions do not affect the BTS.

 

Expansion 2 Frame DIP Switch

The switch settings must be verified and set before power is applied to
the BTS. Refer to Figure 5-2 or  Table 5-3 for Expansion 2 frame.

Table 5-3: Frame ID Switch Position – Expansion 2 Frame

1 2 3 4

UP DN –– ––

–– = Don’t Care. These switch positions do not affect the BTS.

 

Expansion 3 Frame DIP Switch

The switch settings must be verified and set before power is applied to
the BTS. Refer to Figure 5-2 or  Table 5-4 for Expansion 3 frame.

Table 5-4: Frame ID Switch Position – Expansion 3 Frame

1 2 3 4

DN DN –– ––

–– = Don’t Care. These switch positions do not affect the BTS.
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Objective

This procedure check for any electrical problems and verifies the
operation and tolerances of the cell site BTS power supply prior to
applying power for the first time.

Power for EV–DO

Information for applying power to a BTS equipped with EV–DO
(MCC–DO) can be found in 1xEV–DO Hardware Installation manual –
68P09257A95

Test Equipment

The following test equipment is required to perform the Pre–Power Up
test:

S Digital Multimeter (DMM)

Before handling any circuit cards or modules, be sure to
wear a grounding strap to prevent damage from ESD.

CAUTION

Cabling Inspection

Using the site specific documentation generated by Motorola Systems
Engineering, verify that the following cable systems are properly
connected:

S DC Power cabling

S Receive RF cabling

S Transmit RF cabling

S GPS

DC Power Pre–Test

Perform the procedure Table 5-5 in before applying any power to the
BTS.

Table 5-5: BTS DC Pre–Power Test

Step Action

* IMPORTANT
When handling circuit boards and modules, be sure to wear a grounding strap to prevent damages
caused by ESD.

1 Remove front panel cover.

2 Unseat all circuit boards and modules, but do not remove them from their slots.

 table continued on next page
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Table 5-5: BTS DC Pre–Power Test

Step Action

3 At the rear of the BTS, verify that 20 or 25 A circuit breaker is OFF (pulled out). See Figure 5-3 or
Figure 1-9.

4 Use a DMM (set to ohms) and verify the resistance on the –48V or +27V bus.

– Remove the Power Supply Module from the CCP2 Shelf

– Verify that the resistance from the power (+) feed terminal  with respect to ground measures > 500
W  
See Figure 5-3 for –48VDC or Figure 1-9 for +27VDC

– Verify that the resistance from the power (–) feed terminal  with respect to ground measures > 500
W   
See Figure 5-3 for –48VDC or Figure 1-9 for +27VDC

The resistance measurement should not read 0 (zero).

5 Re–seat all circuit boards into their slots

6 Install the Power Supply Module into its slot.

7 Install front panel cover.

  

  GROUND Location
(Screw Holes)

  DC Power
Terminal Strip

 Circuit Breaker
Figure 5-3: Location of Circuit Breaker  for –48 VDC

 20A

cCLPA DC Power Pre–Test

Perform the procedure Table 5-6 in before applying any power to the
cCLPA.
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Table 5-6: cCLPA DC Pre–Power Test

Step Action

1 Ensure that DC power is disengaged at the source. Verify that the DC power cable has been connected
using the procedure in Table 4-8.

2 Remove I/O panel cover.

3 At the bottom of the cCLPA, verify that 20 A circuit breaker to OFF (pulled out). See Figure 5-4.

4 Us a DMM (set to ohms) and verify the resistance on the –48V or +27 V bus.

– Verify that the resistance from the power (+) feed terminal  with respect to ground measures > 500
W 

– Verify that the resistance from the power (–) feed terminal  with respect to ground measures > 500
W  

The resistance measurement should not read 0 (zero).

5 Proceed to Initial Power up procedure in Table 5-11.

  

ti–cdma–wp–00298–v01–ildoc–ah

20A FUSE

Figure 5-4: Bottom View of cCLPA5
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Objective

The objective of this procedure is to verify the AC power for the
Compact BTS outdoor configuration.

Test Equipment

The following test equipment is required to perform the Pre–Power Up
test:

S Digital Multimeter (DMM) or equivalent

Cabling Inspection

Using the site specific documentation generated by Motorola Systems
Engineering, verify that the following cable systems are properly
connected:

S AC Power cabling

S DC Power Cabling

AC power was installed per manufacturer’s installation procedure.

Perform the procedure Table 5-7 in before applying any power to the
TME and cCLPA.

Table 5-7: PDE Initial Power –Up Test

Step Action

* IMPORTANT
To avoid extensive re–work of the PDE and BTS connections, this procedure should be performed
after the PDE and TME are mounted in place.

n WARNING
This equipment uses dangerous voltages and is capable of causing death. Failure to observe this
Warning could result in electrical shock to personnel and damage to equipment. The AC voltage
source should be isolated and locked, and a clearly visible, Warning label attached.

1 Verify that AC power from the source is OFF.

2 If not already done, remove safety shield covering AC terminal block.

3 Connect AC power cable to AC power source.

4 Verify that PDE DC circuit breakers are set to “O” or pulled out (disengaged).

5 Verify that AC power cable is securely connected to PDE AC terminal block.

6 Turn on AC power source.

n WARNING
This equipment uses dangerous voltages and is capable of causing death. Failure to observe this
Warning could result in electrical shock to personnel and damage to equipment. Do not wear jewelry
on hands/fingers when making electrical measurements.

 table continued on next page
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Table 5-7: PDE Initial Power –Up Test

Step Action

7 Using a DMM set toVAC, measure the voltage at the AC terminal block. DMM should indicate
200–240 VAC.  Adjust AC voltage as necessary.

8 Remove DMM.

9 If there is nothing further to do, replace safety shield. Secure to cabinet with 2 nuts and washers. Use
an adjustable wrench to tighten nuts. Torque nuts to 3.4 N–M (20 in–lbs).
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Objective

The objective of this procedure is to verify the Battery Backup DC
power for the Compact BTS outdoor configuration.

Cable Descriptions and Part
Numbers

Table 5-8 gives the cable description and part number for the
recommended cable. Consult manufacturer’s installation guide for
further information.

Table 5-8: Cable Descriptions and Part Numbers

Cable Qty. Part Number Description
{L 1 Customer

Supplied
DC power cables, 10 AWG, stranded, designed for  –60 to –40 VDC
power input

{ Length of cables are dependent upon BTS equipment layout.

 

Test Equipment

The following test equipment is required to perform the Pre–Power Up
test:

S Digital Multimeter (DMM) or equivalent

Tools Required

Relatively small, flat head, screwdriver or equivalent.

Cabling Inspection

Using the site specific documentation generated by Motorola Systems
Engineering, verify that the following cable systems are properly
connected:

S AC Power cabling

S DC Power Cabling

Battery Backup has been installed per the manufacturer’s installation
procedure.

Following the procedure in Table 5-9 to verify Battery Backup DC
power is present.

Table 5-9: Procedure to Verify Battery Backup DC Power Test

Step Action

n WARNING
Do not wear a grounding device or metal of any kind on hands/fingers when working with voltage.
injury to personnel and damage to equipment could occur.

1 Verify that Battery Backup DC Power is disengaged.

 table continued on next page
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Table 5-9: Procedure to Verify Battery Backup DC Power Test

Step Action

2 If not already done, connect Battery Backup DC power cable to batteries.

3 If not already done, remove safety shield covering DC terminal block.

4 Verify that Battery Backup DC power cable is securely connected to DC terminal block of PDE.

5 Verify that circuit breakers on PDE front panel are disengaged (pulled out or set to “O” (OFF)).

6 Turn on Battery Backup source.

7 Using a DMM set to VDC, measure the voltage at the DC terminal block. DMM indicates VDC in the
range –60 – 40 VDC.

8 Remove DMM.

9 If there is nothing further to do, replace safety shield. Secure to cabinet with 2 nuts and washers. Use
an adjustable wrench to tighten nuts. Torque nuts to 3.4 N–M (20 in–lbs).
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Initial Power–Up Tests

Potentially lethal voltage and current levels are present in
the Compact BTS. This test must NOT be performed
without a second person present capable of administering
emergency medical treatment. Remove all decorative metal
before beginning this test. Do NOT wear a grounding strap
when performing voltage measurements.

WARNING

BTS Initial Power–Up

Perform the procedure in Table 5-10 to verify input power. Once power
has been applied the cards and modules within the BTS  should begin
operating within specifications.

Table 5-10: Procedure for BTS Initial Power–Up

Step Action

NOTE
If the BTS is being utilized in an outdoor configuration, perform this procedure after the TME has
been verified as operational.

1 Ensure that DC power source is OFF.

2 Connect DC power to BTS DC Power input.

3 Turn on DC power source.

4 Use a DMM (set to VDC) to verify the –48 V power output is within –60 to –40 VDC.  Adjust DC
power source as necessary. (+27 V is within +20 to +34 VDC)

5 On the BTS, set the 20A or 25 A breaker to ON (push in). See Figure 5-3.

6 If not already done, install the fan module, note that the fan module begins operating. Feel for air
movement at the exhaust vent on top of the BTS.

7 Ensure that all circuit boards and modules are seated and locked into their associated slots.

  

cCLPA Initial Power –Up

Perform the procedure in Table 5-11 to perform the initial power–up.

Table 5-11: Procedure cCLPA Initial Power–Up

Step Action

NOTE
If the cCLPA is being utilized in an outdoor configuration, perform this procedure after the PDE has
been verified as operational.

1 Ensure that DC power source is OFF.

 table continued on next page
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Table 5-11: Procedure cCLPA Initial Power–Up

Step Action

2  If not already done, remove cCLPA I/O panel cover.

3 Connect DC power to cCLPA I/O board DC terminal block.

4 Turn on DC power source.

5 Using a DMM (set to VDC),  measure the voltage at the cCLPA I/O board terminal block.
DC voltage should measure in the range of –60 to –40 VDC or +20 to +34 VDC. Adjust DC power
source as necessary.

6 Remove DMM and install I/O panel cover.

7 On the cCLPA, push in 20 A circuit breaker.

  

Outdoor Configuration Initial
Power Test

TME Initial Power–Up

Perform the procedure Table 5-12 in before applying any power to the
BTS and HMS.

Table 5-12: TME DC Initial Power–Up Test

Step Action

* IMPORTANT
To avoid extensive re–work of the TME and BTS connections, this procedure should be performed
after the TME with BTS is mounted in place.

NOTE
Perform this procedure after the PDE has been verified as operational.

1 Verify that DC power from the PDE is OFF.

2 If not already done, route DC power cable from PDE through conduit to TME.

3 If not already done, remove protective cover from voltage connection on PDA.

4 Use a Phillips screw driver to remove screws from DC power connector on PDA.

5 Set lug of  “–” wire in the –48 VDC (or RTN) location and secure with screw.

6 Set lug of “+” wire in the +0 VDC (or +27 VDC) location and secure with screw.

7 Verify that 1U and TME circuit breakers on PDA are disengaged (pulled out).

8 Turn on PDE supplying the TME.

9 Using a DMM set to VDC, measure the voltage at the PDA connector. DMM should indicate –60 to
–40 VDC.

10 If not already done, connect PDA to HMS Controller (D–connector)

 table continued on next page
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Table 5-12: TME DC Initial Power–Up Test

Step Action

11 If not already done, connect PDA to BTS. (Three appropriately marked cables .)

12 Engage (push in) TME circuit breaker on PDA.

NOTE
Fans on HMS and BTS begin to operate. With TME cable connected the controller for the HMS and
BTS is bypassed, and DC power is supplied as long as the TME circuit breaker is engaged.

13 Using a DMM set to VDC, measure the voltage at the BTS DC Input connector. DMM should indicate
–60 to –40 VDC (or +20 to +34 VDC).

14 Using a DMM set to VDC, measure the voltage at the HMS Controller connector. DMM should
indicate –60 to –40 VDC  (or +20 to +34 VDC).

15 If the 1U connector is being used, engage 1U circuit breaker (push in), use a DMM set to VDC to
measure the voltage at the 1U unit connector. DMM should indicate –60 to –40 VDC (or +20 to +34
VDC).

NOTE
If 1U connector is not in use, do not measure at this time.
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Removing BTS Power

Perform the procedure in Table 5-13, if power must be removed from the
BTS.

Table 5-13: Procedure to Remove Power to BTS

Step Action

1 For indoor configuration, set the 20A or 25 A circuit breaker to OFF (pulled out). See Figure 5-3.

For outdoor configuration, open TME and pull circuit breaker on PDA.

Set TME circuit breaker on PDE to OFF.

2 Confirm all LEDs are OFF.

3 If possible, for added safety, locate circuit breaker of DC power source (PDE or Battery Backup) and
set it to OFF.

  

Removing cCLPA Power

Perform the procedure in Table 5-14, if power must be removed from the
cCLPA.

Table 5-14: Procedure to Remove Power to cCLPA

Step Action

1 Set the 20A circuit breaker to OFF (pulled out). See Figure 5-4.

2 For indoor configuration, turn off DC power source.

For outdoor configuration, set cCLPA circuit breaker on PDE to OFF.

3 Turn off Battery backup DC power (if used).

  

Removing PDE Power

Perform the procedure in Table 5-15, if power must be removed from the
PDE.

Table 5-15: Procedure to Remove Power to PDE

Step Action

1 Turn off AC power source.

2 Turn off Battery Backup DC power (if used).
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Chapter 6: Optimization and Calibration
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Introduction

This section first verifies proper frame equipage against the site-specific
documentation supplied for each BTS application.

Cicruit Backhaul Operation

If circuit backhaul operation is being used, perform the procedures
described in this chapter. Refer to the LMF Help, if further information
is needed.

Packet Backhaul Operation

If packet backhaul configuration is being used, perform the procedures
described in Appendix I.

Peform the IBR procedures described in Appendix G and Appendix H if
GLI3 data load and span parameters need to be verified.

Cell–site Types

The site is configured as Omni with one carrier. The BTS can handle two
carriers.

CDF/NECF

The Configuration Data File (CDF) or Network Element Configuration
File (NECF) contains information that defines the BTS and data used to
download files to the devices. The BTS CDF (bts–#.cdf) and CBSC
CDF (cbsc–#.cdf ) files are used by circuit BTSs. The NEC Base
(NECB – NECB*bts#.xml ) and NEC Journaling (NECJ–
NECJ*bts#.xml ) files are used by packet BTSs. CDF or NEC files
must be placed in the applicable BTS folder before the LMF can be used
to log into that BTS. CDF and NEC files are normally obtained from the
CBSC using a floppy disk. A file transfer protocol (ftp) method can be
used if the LMF computer has that capability.

The CDF and NEC files include the following information:

S Download instructions and protocol

S Site specific equipage information

S CCP2 Shelf allocation plan

– BBX equipage

– CSA equipage

– MCC–1X (16, 24,32, 64) channel element allocation plan. This plan
indicates how the CCP2 shelf is configured, and how paging,
synchronization, traffic, and access channel elements (and
associated gain values) are assigned among the (up to 3) MCC–1Xs
in the shelf.

S CSA equipage
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S Effective Rate Power (ERP) table for all TX channels to antennas
respectively. Motorola System Engineering specifies the ERP of a
transmit antenna based on the site geography, antenna placement, and
government regulations. Working from this ERP requirement, the
antenna gain, (dependent on the units of measurement specified) and
antenna feed line loss can be combined to determine the required
power of the BTS. The corresponding BBX–1X output level required
to achieve that power level on any channel/sector can also be
determined.

Refer to the LMF Help function on–line documentation for
additional information on the layout of the LMF directory
structure (including CDF or NEC file locations and
formats).

NOTE

Site Equipage Verification

Review the site documentation. Match the site engineering equipage data
to the actual boards and modules shipped to the site. Physically inspect
and verify the equipment provided for the frame.

Always wear an approved anti–static wrist strap while
handling any circuit card/module to prevent damage by
ESD. After removal, the card/module should be placed on
a conductive surface or back into the anti–static packaging
in which it was shipped.

CAUTION

Initial Installation of
Boards/Modules

Table 6-1: Initial Installation of Boards/Modules

Step Action

1 Refer to the site documentation and, if it was not previously done, slide all boards and modules into
the appropriate shelves as required. DO NOT SEAT the boards and modules at this time.

2 As the actual site hardware is installed, record the serial number of each module on a “Serial Number
Checklist” in the site logbook.
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Ethernet LAN Termination

For proper operation, the BTS Ethernet Local Area Network (LAN)
connections must be terminated with a 50–ohm loads. This is done by
placing four (4) 50–ohm BNC terminations on the LAN A and B
external IN and OUT connectors located on the rear of the BTS.  This is
only done on stand–alone BTSs. The front panel LAN connections are
not terminated with loads.

Verify that the LAN A and B external IN and OUT connectors at the rear
of the BTS have terminations installed. See Figure 6-1 for locations.

Figure 6-1: LAN Connectors
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Overview

This section describes procedures for isolating the BTS from the span
lines, preparing and using the WinLMF, downloading system operating
software, CSA reference verification/optimization, set up and calibration
of the supported test equipment, and transmit/receive paths are
functioning properly.

Before using the WinLMF, use an editor to view the
“CAVEATS” section in the “readme.txt” file in the c:\wlmf
folder for any applicable information.

NOTE

Optimization Process
Summary

After a BTS is physically installed and the preliminary operations, such
as power up, have been completed, the WinLMF is used to optimize the
BTS.  The basic optimization process consists of the following:

1. Download GLI3 (GLI–bts#–1) with application code and data and
then enable GLI3.

2. Use the WinLMF status function and verify that all of the installed
devices of the following types respond with status information:
CSA, BBX, GLI3, and MCC. If a device is installed and powered up
but is not responding and is colored gray in the BTS display, the
device is not listed in the CDF file. The CDF/NECF file must be
corrected before the device can be accessed by the WinLMF.

3. Download device application code and data to all devices of the
following types:

– CSA

– BBX–1X

– MCC–1X

4. Verify the operation of the GPS and HSO/MSO signals.

5. Using the WinLMF test equipment selection function, select the test
equipment to be used for the calibration.

6. Calibrate the TX and RX test cables if they have not previously been
calibrated with the WinLMF computer and software build which will
be used for the optimization/calibration. Cable calibration values can
be entered manually, if required.

7. Connect the required test equipment for a full optimization.

8. Select all of the BBXs and all of the MCCs and use the full
optimization function. The full optimization function performs TX
calibration, BLO download, TX audit, all TX tests, and all RX tests
for all selected devices.

9. If the TX calibration fails, repeat the full optimization for any failed
paths.
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10. If the TX calibration fails again, troubleshoot and correct the
problem causing the failure, and repeat the full optimization for the
failed path.

11. If the TX calibration and audit portion of the full optimization passes
for a path but some of the TX or RX tests fail, troubleshoot and
correct the problem causing the failure, and run the individual tests
as required until all TX and RX tests have passed for all paths.

Cell-site Types

The site is configured as Omni/Omni. Each cell site type has unique
characteristics and must be optimized accordingly.

CDF/NECF

The CDF/NECF (Configuration Data File/Network Element
Configuration File) contains information that defines the BTS and data
used to download files to the devices. A CDF/NECF file must be placed
in the applicable BTS folder before the WinLMF can be used to log into
that BTS. CDF/NECF files are normally obtained from the CBSC using
a floppy disk. A file transfer protocol (ftp) method can be used if the
WinLMF computer has that capability. Refer to the WinLMF Help
function on–line documentation for more information.

The CDF/NECF includes the following information:

S Download instructions and protocol

S Site specific equipage information

S CCP2 Shelf allocation plan

– BBX equipage (based on cell–site type) including IS–95A/B or
CDMA2000 1X capability and redundancy

– CSA equipage including redundancy

– Multi–Channel CDMA Card 1X channel element allocation plan.
This plan indicates how the CCP2 Shelf is configured, and how the
paging, synchronization, traffic, and access channel elements (and
associated gain values) are assigned among the (up to 3) MCC–1Xs
in the shelf.

S Effective Rated Power (ERP) table for all TX channels to antennas
respectively. Motorola System Engineering specifies the ERP of a
transmit antenna based on site geography, antenna placement, and
government regulations. Working from this ERP requirement, antenna
gain and antenna feed line loss can be combined to calculate the
required transmit power at the frame antenna connections. The
corresponding BBX output power required to achieve that power level
on any channel/sector can then be determined based on Bay Level
Offset (BLO) data established during the optimization process.
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Refer to Figure 6-2 and the WinLMF Help function on–line
documentation for additional information on the layout of
the WinLMF directory structure (including CDF/NECF file
locations and formats).

NOTE

BTS System Software
Download

BTS system software must be successfully downloaded to the BTS
processor boards before optimization can be performed. BTS operating
code is loaded from the WinLMF computer terminal.

The BTS is configured for Circuit Backhaul and uses bts.cdf files. BTSs
configured for Packet Backhaul use bts.necf files (bts–xxx.xml) located
on the OMC–R.

Before using the WinLMF for optimization/ATP, the
correct bts–#.cdf (or bts–#.necf) and cbsc–#.cdf files for
the BTS must be obtained from the CBSC and put in a
bts–# folder in the WinLMF. Failure to use the correct
CDF/NECF files can cause wrong results. Failure to use
the correct CDF/NECF files to log into a live (traffic
carrying) site can shut down the site.

NOTE

The CDF/NECF is normally obtained from the CBSC on a DOS
formatted diskette, or through a file transfer protocol (ftp) if the
WinLMF computer has ftp capability. Refer to the WinLMF Help
function on–line documentation for the procedure.

Site Equipage Verification

If you have not already done so, use an editor to view the CDF/NECF,
and review the site documentation. Verify the site engineering equipage
data in the CDF/NECF matches the actual site hardware using a
CDF/NECF conversion table.

Use extreme care not to make any changes to the
CDF/NECF content while viewing the file. Changes to the
CDF/NECF can cause the site to operate unreliably or
render it incapable of operation.
Always wear a conductive, high impedance wrist strap
while handling any circuit card/module to prevent damage
by ESD. Extreme care should be taken during the removal
and installation of any card/module. After removal, the
card/module should be placed on a conductive surface or
back into the anti–static bag in which it was shipped.

CAUTION
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Overview of Packet BTS files

R16.0 and earlier releases had the configuration file called CDF for each
BTS and CBSC used by WinLMF. In 16.1 Packet BTS, BTS with GLI3
booting in packet binary, the CDF is replaced by two new configuration
files called Network Element Configuration Base (NECB) and Network
Element Change Journal (NECJ). The NECB contains the baseline
configuration and is analogous to the CDF, while the NECJ contains all
the changes made to the configuration since the last time the NECB was
re–generated. Once the NECJ gets to 80% of its maximum size, the
NECB is re–generated and all the updates are rolled into it.

These files play much broader and vital role than previous CDF files.
GLI3 booting in circuit binaries works similar to R16.0.

A few WinLMF related important facts about these files are listed below.

S Both files (NECB and NECJ) are in XML format.

S NECB contains all the up-to-date static configuration information and
NECJ contains all the recent changes (including operations) which are
not updated in the NECB.

S Both files can be viewed in any XML viewer (most easily available is
Internet Explorer V5.0 and higher). They can be also viewed by any
other word processor, but the XML tags will also be seen with them.

S These files will be created by OMC–R from MIB as per the BTS
provisioning.

S These files will be regenerated for each software release upgrade on
the system for each BTS.

S These files will reside on both OMC–R and Packet–GLI3 (unlike
CDF) and will be synchronized periodically between them.

S Both NECB and NECJ file contain a “SoftwareVersion” field in their
header section indicating the system release version of these files.

S Instead of the bts#.cdf file, the packet WinLMF uses a bts#.XML file,
which is a copy of the NECB.XML file.

S Packet–GLI3 will need these files for site initialization.

S The scope of NECB has grown much broader than CDF and has much
more BTS centric information. The use of generic version of these
files should be strictly avoided for the correct site initialization.
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WinLMF Features and
Installation Requirements

Before optimization can be performed, the WinLMF application software
must be installed and configured on a computer platform meeting
Motorola–specified requirements.

For the WinLMF graphics to display properly, the
computer platform must be configured to display more
than 256 colors. See the operating system software
instructions for verifying and configuring the display
settings.

NOTE

Software and files for installing and updating the WinLMF are provided
on CD ROM disks. The following items must be available:

S WinLMF application program on CD ROM

S CDF/NECF for each supported BTS (on diskette or available from the
CBSC)

S CBSC File for each supported BTS (on floppy disk or CD ROM)

FTP Server

To be able to download files to the GLI3, the WinLMF now runs FTP
server on the WinLMF laptop. The WinLMF FTP server runs from the
LMFs home directory. All the files necessary to run the WinLMF FTP
server are installed from the WinLMF CD. The FTP server is
automatically started by the WinLMF upon successful Login to a Packet
BTS.

In addition, the WinLMF provides a new option in the Tools menu called
FTP Server. The option starts the LMFs FTP server if Start is selected,
and stops the server if Stop is selected. The LMFs FTP server runs on
port 21. If any other process is using that port, the error message is
displayed to the user stating that the port is occupied. There is another
option under FTP Server menu called FTP Monitor, which allows the
user to watch FTP activity b/w the WinLMF and GLI.

Firewalls

Firewalls will block the FTP requests from the Packet GLI to the
WinLMF laptop. You must disable your firewall before attempting the
BTS Synch command. Some common firewall programs to look for
include Network ICE, BlackICE, Norton’s Desktop Firewall, Enterprise
Firewall, and Personal Firewall.
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FTP Server Port in use

On some Windows 2000 installations, a process called “inetd.exe”
makes the FTP server port 21 unusable by the WinLMF. If the WinLMF
reports that the FTP server could not start because the port is in use,
make sure the inetd.exe is not running by using the Task Manager’s
process list. If inetd.exe is running, end the process by selecting it and
clicking the “End Process” button. Inetd32.exe is NOT the same and
ending it will not resolve this problem.

WinLMF File Structure
Overview

The WinLMF uses a <x>:\<lmf home directory> folder that contains all
of the essential data for installing and maintaining the BTS. The
following list outlines the folder structure for WinLMF. Except for the
bts-nnn folders, these folders are created as part of the WinLMF
installation. Refer to the CDMA WinLMF Operator’s Guide for a
complete description of the folder structure.

Figure 6-2: WinLMF Folder Structure

version folder (A separate folder is
required for each different version; for
example, a folder name 2.8.1.1.1.5.)

loads folder

(C:)

x:\<lmf home directory> folder

cdma folder

code folder

data folder

BTS–nnn folders (A separate folder is
required for each BTS where bts–nnn is the
unique BTS number; for example, bts–163.)

The “loads” folder and all the folders below it are not
available from the WinLMF for Software Release 2.16.3.x.
These folders may be present as as a legacy from previous
software versions or downloaded from the OMC–R/CBSC.

NOTE

WinLMF Home Directory

The WinLMF installation program creates the default home directory,
c:\wlmf , and installs the application files and subdirectories (folders)
in it. Because this can be changed at installation, the CDMA WinLMF
home directory will be referred to with the generic convention of:
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<x>:\<lmf home directory>

Where:

<x> = the WinLMF computer drive letter where the CDMA WinLMF
home directory is located.

<lmf home directory> = the directory path or name where the CDMA
WinLMF is installed.

NECF Filename Conventions
and Directory Location

NECF

The NECF actually consists of two files: the NECB  and NECJ. The
naming convention for the NECB and NECJ is:

NECB*bts#.xml

NECJ*bts#.xml

Where:

* = any characters can be substituted there

# = the actual integer BTS number

The NECB and its corresponding NECJ must have the exact same name,
except for the “B” and “J” difference after the initial NEC characters.

The NECB and the NECJ must reside in the
<WinLMF_HOME>\cdma\bts–# directory corresponding to the BTS
frame they are for.

Load Information File (LIF)

The LIF contains all the devices binaries available for the specified
System Software Release. It is the functional equivalent of the OLF file
that was used pre–Packet.

The naming convention for the LIF is:

NE_LIF.xml

The LIF must reside in the <WinLMF_HOME>\cdma\loads\<Software
Release Number> directory, where <WinLMF_HOME> = the home
directory in which the WinLMF is installed, usually C:\wlmf <Software
Release Number> = the System Software Release Number (e.g.
2.16.1.0.10).

Cal File

The Cal File still resides in the <WinLMF_HOME>\cdma\bts–#
directory and is named bts–#.cal, where # is the actual integer number of
the BTS.

6



Preparing the LMF  – continued

MAY 2004 1X SC480 BTS Hardware Installation, Optimization/ATP, and FRU  6-11

PRELIMINARY

WinLMF Operating System
Installation

This section provides information and instructions for installing and
updating the WinLMF software and files.

First Time Installation Sequence

S Install Java Runtime Environment (JRE)

S Install U/WIN K–shell emulator

S Install WinLMF application programs

S Install/create BTS folders

Any time you install U/WIN, you must install the
WinLMF software because the installation of the WinLMF
modifies some of the files that are installed during the
U/Win installation. Installing U/Win over–writes these
modifications.
There are multiple binary image packages for installation
on the CD–ROM. When prompted, choose the load that
corresponds to the switch release that you currently have
installed. Perform the Device Images install after the
WinLMF installation.
If applicable, a separate CD ROM of BTS Binaries may be
available for binary updates.

NOTE

Follow the procedure in Table 6-2 to install the WinLMF application
program using the WinLMF CD ROM.

Table 6-2: Install WinLMF using CD ROM

n Step Action

1 Insert the WinLMF CD ROM disk into your disk drive and perform the following as required:

1a – If the Setup screen appears, follow the instructions displayed on the screen.

1b – If the Setup screen is not displayed, proceed to Step 2.

2 Click on the Start button

3 Select Run.

4 Enter d:\autorun in the Open box and click OK.

NOTE
If applicable, replace the letter d with the correct CD ROM drive letter.
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Copy BTS CDF (or NECF) and
CBSC CDF Files to the WinLMF
Computer

Before logging on to a BTS with the WinLMF computer to execute
optimization/ATP procedures, the correct bts-#.cdf (or bts–#.necf) and
cbsc-#.cdf files must be obtained from the CBSC and put in a bts-#
folder in the WinLMF computer. This requires creating versions of the
CBSC CDF files on a DOS–formatted floppy diskette and using the
diskette to install the CDF files on the WinLMF computer.

If the WinLMF has ftp capability, the ftp method can be
used to copy the CDF or NECF files from the CBSC.
On Sun OS workstations, the unix2dos command can be
used in place of the cp command (e.g., unix2dos
bts–248.cdf bts–248.cdf). This should be done using a
copy of the CBSC CDF file so the original CBSC CDF file
is not changed to DOS format.
When copying CDF or NECF files, comply with the
following to prevent BTS login problems with the
Windows WinLMF:

– The numbers used in the bts-#.cdf (or bts–#.necf)
and cbsc-#.cdf filenames must correspond to the
locally-assigned numbers for each BTS and its
controlling CBSC.

– The generic cbsc–1.cdf file supplied with the
Windows WinLMF will work with locally numbered
BTS CDF files. Using this file will not provide a
valid optimization unless the generic file is edited to
replace default parameters (e.g., channel numbers)
with the operational parameters used locally.

NOTE

The procedure in Table 6-3 lists the steps required to transfer the CDF
files from the CBSC to the WinLMF computer. For further information,
refer to the WinLMF Help function on–line documentation.

Table 6-3: Copying CDF or NECF Files to the WinLMF Computer

n Step Action

AT THE CBSC:

1 Login to the CBSC workstation.

2 Insert a DOS–formatted floppy diskette in the workstation drive.

3 Type eject –q and press the Enter key.

. . . continued on next page
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Table 6-3: Copying CDF or NECF Files to the WinLMF Computer

n ActionStep

4 Type mount and press the Enter key.

NOTE
S Look for the “floppy/no_name” message on the last line displayed.

S If the eject command was previously entered, floppy/no_name will be appended with a number.
Use the explicit floppy/no_name reference displayed when performing step 7.

5 Change to the directory, where the files to be copied reside, by typing cd <directoryname>
(e.g., cd bts–248) and pressing the Enter key.

6 Type ls and press the Enter key to display the list of files in the directory.

7 With Solaris versions of Unix, create DOS–formatted versions of the bts-#.cdf (or bts–#.necf) and
cbsc-#.cdf files on the diskette by entering the following command:

unix2dos <source filename>  /floppy/no_name/<target filename>
(e.g., unix2dos bts–248.cdf  /floppy/no_name/bts–248.cdf).

NOTE
S Other versions of Unix do not support the unix2dos and dos2unix commands. In these cases, use

the Unix cp (copy) command. The copied files will be difficult to read with a DOS or Windows text
editor because Unix files do not contain line feed characters. Editing copied CDF files on the
WinLMF computer is, therefore, not recommended.

S Using cp, multiple files can be copied in one operation by separating each filename to be copied
with a space and ensuring the destination directory (floppy/no_name) is listed at the end of the
command string following a space (e.g., cp  bts–248.cdf  cbsc–6.cdf  /floppy/no_name).

8 Repeat Steps 5 through 7 for each bts–# that must be supported by the WinLMF computer.

9 When all required files have been copied to the diskette type eject and press the Enter key.

10 Remove the diskette from the CBSC drive.

AT THE WinLMF:

11 If it is not running, start the Windows operating system on the WinLMF computer.

12 Insert the diskette containing the bts-#.cdf (or bts–#.necf) and cbsc-#.cdf files into the WinLMF
computer.

13 Using MS Windows Explorer, create a corresponding bts–# folder in the <x>:\<lmf home
directory>\cdma directory for each bts–#.cdf/cbsc–#.cdf (or bts–#.necf/cbsc–#.cdf) file pair copied
from the CBSC.

14 Use MS Windows Explorer to transfer the  bts-#.cdf (or bts–#.necf) and cbsc-#.cdf files from the
diskette to the corresponding <x>:\<lmf home directory>\cdma\bts–# folders created in Step 13.
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Creating a Named
HyperTerminal Connection for
MMI Communication

Confirming or changing the configuration data of certain BTS Field
Replaceable Units (FRU) requires establishing an MMI communication
session between the WinLMF and the FRU. Using features of the
Windows operating system, the connection properties for an MMI
session can be saved on the WinLMF computer as a named Windows
HyperTerminal connection. This eliminates the need for setting up
connection parameters each time an MMI session is required to support
optimization.

Once the named connection is saved, a shortcut for it can be created on
the Windows desktop. Double–clicking the shortcut icon will start the
connection without the need to negotiate multiple menu levels.

Follow the procedures in Table 6-4 to establish a named HyperTerminal
connection and create a Windows desktop shortcut for it.

Table 6-4: Create HyperTerminal Connection

Step Action

1 From the Windows Start menu, select:

Programs>Accessories>

2 Perform one of the following:

S For Win NT, select Hyperterminal and then click on HyperTerminal or

S For Win 98, select Communications, double click the Hyperterminal folder, and then double click
on the Hyperterm.exe icon in the window that opens.

NOTE
S If a Location Information Window appears, enter the required information, then click on the

Close button. (This is required the first time, even if a modem is not to be used.)

S If a You need to install a modem..... message appears, click on NO.

3 When the Connection Description box opens:

– Type a name for the connection being defined (e.g., MMI Session) in the Name: window,

– Highlight any icon preferred for the named connection in the Icon: chooser window, and

– Click  OK.

4 From the Connect using: pick list in the Connect To box displayed, select COM1 or COM2 (Win
NT) – or Direct to Com 1 or Direct to Com 2 (Win 98) for the RS–232 port connection and click OK.

NOTE
For WinLMF computer configurations where COM1 is used by another interface such as test
equipment and a physical port is available for COM2, select COM2 in the following step to prevent
conflicts.

. . . continued on next page
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Table 6-4: Create HyperTerminal Connection

Step Action

5 In the Port Settings tab of the COM# Properties window displayed, configure the RS–232 port
settings as follows:

S Bits per second:  9600

S Data bits:  8

S Parity:  None

S Stop bits:  1

S Flow control:  None

6 Click OK.

7 Save the defined connection by selecting:

File > Save

8 Close the HyperTerminal window by selecting:

File > Exit

9 Click the Yes button to disconnect when prompted.

10 Perform one of the following:

S If the Hyperterminal folder window is still open (Win 98) proceed to step 12

S From the Windows Start menu, select Programs > Accessories.

11 Perform one of the following:

S For Win NT, select Hyperterminal and release any pressed mouse buttons.

S For Win 98, select Communications and double click the Hyperterminal folder.

S For Win–XP, select Communications and double click the Hyperterminal folder.

12 Highlight the newly–created connection icon by clicking on it.

13 Right click and drag the highlighted connection icon to the Windows desktop and release the right
mouse button.

14 From the popup menu which appears, select Create Shortcut(s) Here.

15 If desired, reposition the shortcut icon for the new connection by dragging it to another location on the
Windows desktop.

16 Close the Hyperterminal folder window by selecting:

File > Close
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T1/E1 Span Interface

At active sites, the OMC–R/CBSC must disable the BTS
and place it out–of–service (OOS). DO NOT remove the
span line cable connectors until the OMC–R/CBSC has
disabled the BTS.

NOTE

Before connecting the WinLMF computer to the BTS LAN, the
OMC–R/CBSC must disable the BTS and place it OOS. This will allow
the WinLMF to control the BTS, and prevent the CBSC from
inadvertently sending control information to the BTS during
WinLMF–based tests.

Isolate BTS from T1/E1 Spans

Once the OMC–R/CBSC has disabled the BTS, the spans must be
disabled to ensure the WinLMF will maintain control of the BTS.

T1/E1 Span Isolation

Table 6-5 describes the action required for span isolation.

Table 6-5: T1/E1 Span Isolation

Step Action

1 Have the OMC–R/CBSC operator place the BTS OOS.

2 To disable the span lines, disconnect the span or spans from the CBIO Network Span–1X or Group 1
Span–EVDO sockets.

If in an outdoor configuration, then unlock and open TME left side door  to gain access to rear of BTS.
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Connect the WinLMF to the
BTS

The WinLMF computer may be connected to the LAN A or B connector
located on the front panel or at the rear of the BTS. Figure 6-3 below
shows the general location of these connectors. LAN A is considered the
primary LAN.

Table 6-6: Connecting the WinLMF to the BTS 

n Step Action

1 For indoor configuration, remove BTS front panel cover.

For outdoor configuration, unlock and open TME right side door and remove BTS front panel cover.

NOTE
Xircom Model PE3–10B2 or equivalent can also be used to interface the WinLMF Ethernet
connection to the BTS frame connected to the PC parallel port, powered by an external AC/DC
transformer. In this case, the BNC cable must not exceed 91 cm (3 ft) in length.

2 Connect the WinLMF computer to the LAN A (left–hand) BNC connector . (See Figure 6-3)

* IMPORTANT
The LAN shield is isolated from chassis ground. The LAN shield (exposed portion of BNC connector)
must not touch the chassis during optimization.

ETHERNET B LMF
CONNECTION

Remove panel to gain
access to the site 1 or
site 2 LMF BNC
connector. ETHERNET A LMF

CONNECTION

PCMCIA ETHERNET
ADAPTER

10BASET/10BASE2
CONVERTER CONNECTS

DIRECTLY TO LAN A    

115 VAC POWER
CONNECTION

FRONT OF BTS
WITH PANEL
COVER REMOVED

Figure 6-3: WinLMF Connection Detail

If lap top is equipped with an
ethernet port, then PCMCIA
ethernet adapter is not required
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Basic LMF Operation

LMF Coverage in This Publication – The LMF application program
supports maintenance of both CDMA and SAS BTSs. All references to
the LMF in this publication are to the CDMA portion of the program.

Operating Environments – The LMF application program allows the
user to work in the two following operating environments which are
accessed using the specified desktop icons:

S Graphical User Interface (GUI) using the WinLMF icon

S Command Line Interface (CLI) using the WinLMF CDMA CLI icon

The GUI is the primary optimization and acceptance testing operating
environment. The CLI environment provides additional capability to the
user to perform manually controlled acceptance tests and audit the
results of optimization and calibration actions.

Basic Operation – Basic operation of the LMF in either environment
includes performing the following:

S Selecting and deselecting BTS devices

S Enabling devices

S Disabling devices

S Resetting devices

S Obtaining device status

The following additional basic operation can be performed in a GUI
environment:

S Sorting a status report window

For detailed information on performing these and other LMF operations,
refer to the LMF Help function on–line documentation.

Unless otherwise noted, LMF procedures in this manual
are performed using the GUI environment.

NOTE
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The LMF Display and the BTS

BTS Display – When the LMF is logged into a BTS, a frame tab is
displayed for each BTS frames. The frame tab will be labeled with
“CDMA” and the BTS number, a dash, and the frame number (for
example, BTS–812–1 for BTS 812, RFMF 1). If there is only one frame
for the BTS, there will only be one tab.

CDF/NECF Requirements – For the LMF to recognize the devices
installed in the BTS, a BTS CDF/NECF file which includes equipage
information for all the devices in the BTS must be located in the
applicable <x>:\<lmf home directory>\cdma\bts–# folder. To provide
the necessary channel assignment data for BTS operation, a CBSC CDF
file which includes channel data for all BTS RFMFs is also required in
the folder.

Graphical User Interface
Overview

The LMF uses a GUI, which works in the following way:

S Select the device or devices.

S Select the action to apply to the selected device(s).

S While action is in progress, a status report window displays the action
taking place and other status information.

S The status report window indicates when the the action is complete
and displays other pertinent information.

S Clicking the OK button closes the status report window.

Understanding GUI Operation

The following screen captures are provided to help understand how the
GUI operates:

– Figure 6-4 depicts the differences between packet and circuit
CDMA “cdf” file identification. Note that if there is a packet
version “bts” file, the “(P)” is added as a suffix. There is a
corresponding “(C)” for the circuit mode version.

– Figure 6-5 depicts the Self-Managed Network Elements (NEs) state
of a packet mode. Note that an “X” is on the front of each card that
is under Self–Managed Network Elements (NEs) control by the
GLI3 card.

– Figure 6-6 depicts three of the available packet mode commands.
Normally the GLI3 has Self-Managed Network Elements (NEs)
control of all cards as shown in Figure 6-5 by an “(X)”. In that state
the LMF may only status a card. In order to download code or test a
card, the LMF must request Self-Managed Network Elements (NEs)
control of the card by using the shown dropdown menu. It also uses
this menu to release control of the card back to the GLI3. The GLI3
will also assume control of the cards after the LMF logs out of the
BTS. The packet mode GLI3 normally is loaded with a tape release
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and NECB and NECJ files which point to a tape release stored on
the GLI3. When the GLI3 has control of a card it will maintain that
card with the code on that tape release.

– Figure 6-7 depicts a packet mode site that has the MCC–1 and the
BBX–1 cards under LMF control. Notice that the “X” is missing
from the front of these two cards.

For detailed information on performing these and other LMF operations,
refer to the LMF Help function on–line documentation.

Figure 6-4: BTS Login Screen – Identifying Circuit and Packet BTS Files
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Figure 6-5: Self–Managed Network Elements (NEs) State of a Packet Mode
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Figure 6-6: Available Packet Mode Commands
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Figure 6-7: Packet Mode Site with MCC–1 and BBX–1 under LMF Control
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Command Line Interface
Overview

The LMF also provides Command Line Interface (CLI) capability.
Activate the CLI by clicking on a shortcut icon on the desktop. The CLI
can not be launched from the GUI, only from the desktop icon.

Both the GUI and the CLI use a program known as the handler. Only one
handler can be running at one time. The architectural  design is such that
the GUI must be started before the CLI if you want the GUI and CLI to
use the same handler.

When the CLI is launched after the GUI, the CLI automatically finds and
uses an in–progress login session with a BTS initiated under the GUI.
This allows the use of the GUI and the CLI in the same BTS login
session.

If a CLI handler is already running when the GUI is launched (this
happens if the CLI window is already running when the user starts the
GUI, or if another copy of the GUI is already running when the user
starts the GUI), a dialog window displays the following warning
message:

The CLI handler is already running.
This may cause conflicts with the LMF.
Are you sure that you want to start the application?

This window also contains yes and no buttons. Selecting yes starts the
application. Selecting no terminates the application.

CLI Format Conventions

The CLI command can be broken down in the following way:

S Verb

S Device including device identifier parameters

S Switch

S Option parameters consisting of:

– Keywords

– Equals sign (=) between the keyword and the parameter value

– Parameter values

Spaces are required between the verb, device, switch, and option
parameters. A hyphen is required between the device and its identifiers.
Following is an example of a CLI command.

measure bbx–<bts_id>–<bbx_id> rssi channel=6 sector=5

Refer to the LMF CLI Commands for a complete explanation of the CLI
commands and their usage.
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Logging Into a BTS

Logging into a BTS establishes a communication link between the BTS
and the LMF. An LMF session can be logged into only one BTS at a
time.

Prerequisites

Before attempting to log into a BTS, ensure the following have been
completed:

S The LMF is correctly installed on the LMF computer.

S A bts-nnn folder with the correct CDF/NECF and CBSC files exists.

S The LMF computer was connected to the BTS before starting the
Windows operating system and the LMF software. If necessary, restart
the computer after connecting it to the BTS in accordance with
Table 6-6 and Figure 6-3.

Be sure that the correct bts–#.cdf/necf and cbsc–#.cdf file
are used for the BTS. These should be the CDF/NECF files
that are provided for the BTS by the CBSC. Failure to use
the correct CDF/NECF files can result in invalid
optimization. Failure to use the correct CDF/NECF files
to log into a live (traffic–carrying) site can shut down
the site.

CAUTION

BTS Login from the GUI Environment

Follow the procedures in Table 6-7 to log into a BTS when using the
GUI environment.

Table 6-7: BTS GUI Login Procedure

n Step Action

1 Start the LMF GUI environment by double–clicking on the WinLMF desktop icon (if the LMF is
not running).

– An LMF window will open and display the LMF build number in the title bar.

NOTE
If a warning similar to the following is displayed, select No, shut down other LMF sessions which
may be running, and start the LMF GUI environment again:

The CLI handler is already running.
This may cause conflicts with the LMF.
Are you sure you want to start the application?

Yes No

2 Click on Login tab (if not displayed).

3 Double click on CDMA (in the Available Base Stations pick list).

. . . continued on next page
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Table 6-7: BTS GUI Login Procedure

n ActionStep

4 Click on the desired BTS number.

5 Click on the Network Login tab (if not already in the forefront).

6 Enter correct IP address (normally 128.0.0.2) for a field BTS, if not correctly displayed in the IP
Address box.

7 Type in the correct IP Port number (normally 9216) if not correctly displayed in the IP Port box.

8 Click on Ping.

– If the connection is successful, the Ping Display window shows text similar to the following:

Reply from 128 128.0.0.2: bytes=32 time=3ms TTL=255

– If there is no response the following is displayed:

128.0.0.2:9216:Timed out

If the GLI fails to respond, reset and perform the ping process again. If the GLI still fails to
respond, typical problems are shorted BNC to inter–frame cabling, open cables, crossed A and B
link cables, missing 50–Ohm terminators, or the GLI itself.

9 If required, match the device corresponding to the BTS configuration by  selecting
Multi-channel Preselector type from the Multi-channel Preselector drop–down list (default is
MPC).

10 Click on Login. (A BTS tab with the BTS and frame numbers is displayed.)

NOTE
S If an attempt is made to log into a BTS that is already logged on, all devices will be gray.

S There may be instances where the BTS initiates a log out due to a system error (i.e., a device
failure).

S If the GLI is OOS–ROM (blue), it must be downloaded with RAM code before other devices
can be seen.

S If the GLI is OOS–RAM (yellow), it must be enabled before other installed devices can be seen.
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BTS Login from the CLI Environment

Follow the procedures in Table 6-8 to log into a BTS when using the
CLI environment.

If the CLI and GUI environments are to be used at the
same time, the GUI must be started first and BTS login
must be performed from the GUI. Refer to Table 6-7 to
start the GUI environment and log into a BTS.

NOTE

Table 6-8: BTS CLI Login Procedure

n Step Action

1 Double–click the WinLMF CLI desktop icon (if the LMF CLI environment is not already
running).

NOTE
If a BTS was logged into under a GUI session before the CLI environment was started, the CLI
session will be logged into the same BTS, and step 2 is not required.

2 At the /wlmf prompt, enter the following command:

login bts–<bts#>  host=<host>  port=<port>

where:

host = GLI card IP address (defaults to address last logged into for this BTS or 128.0.0.2 if this is
first login to this BTS)

port = IP port of the BTS (defaults to port last logged into for this BTS or 9216 if this is first login
to this BTS)

A response similar to the following will be displayed:

LMF>
13:08:18.882 Command Received and Accepted
             COMMAND=login bts–33

13:08:18.882 Command In Progress

13:08:21.275 Command Successfully Completed
             REASON_CODE=”No Reason”
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Logging Out

Logging out of a BTS is accomplished differently for the GUI and CLI
operating environments.

The GUI and CLI environments use the same connection to
a BTS. If a GUI and the CLI session are running for the
same BTS at the same time, logging out of the BTS in
either environment will log out of it for both. When either
a login or logout is performed in the CLI window, there is
no GUI indication that the login or logout has occurred.

NOTE

Logging Out of a BTS from the GUI Environment
Follow the procedure in Table 6-9 to logout of a BTS when using the
GUI environment.

Table 6-9: BTS GUI Logout Procedure

n Step Action

1 Click on BTS in the BTS menu bar.

2 Click the Logout item in the pull–down menu (a Confirm Logout pop-up message will appear).

3 Click on Yes (or press the Enter key) to confirm logout. The Login tab will appear.

NOTE
If a logout was previously performed on the BTS from a CLI window running at the same time as
the GUI, a Logout Error pop–up message will appear stating the system could not log out of the
BTS. When this occurs, the GUI must be exited and restarted before it can be used for further
operations.

4 If a Logout Error pop–up message appears stating that the system could not log out of the Base
Station because the given BTS is not logged in, click OK and proceed to Step 5.

5 Select File > Exit in the window menu bar, click Yes in the Confirm Logout pop–up, and click
OK in the Logout Error pop–up which appears again.

6 If further work is to be done in the GUI, restart it.

NOTE
S The Logout item on the BTS menu bar will only log you out of the displayed BTS.

S You can also log out of all BTS sessions and exit LMF by clicking on the File selection in the
menu bar and selecting Exit from the File menu list. A Confirm Logout pop–up message will
appear.
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Logging Out of a BTS from the CLI Environment

Follow the procedure in Table 6-10 to logout of a BTS when using the
CLI environment.

Table 6-10: BTS CLI Logout Procedure

n Step Action

NOTE
If the BTS is also logged into from a GUI running at the same time and further work must be done
with it in the GUI, proceed to Step 2.

1 Log out of a BTS by entering the following command:

logout bts–<bts#>

A response similar to the following will be displayed:

LMF>
13:24:51.028 Command Received and Accepted

COMMAND=logout bts–33
13:24:51.028 Command In Progress
13:24:52.04 Command Successfully Completed

REASON_CODE=”No Reason”

2 If desired, close the CLI interface by entering the following command:

exit

A response similar to the following will be displayed before the window closes:

Killing background processes....
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Establishing an MMI
Communication Session

Equipment Connection – Figure 6-8 illustrates common equipment
connections for the LMF computer. For specific connection locations on
FRUs, refer to the illustration accompanying the procedures which
require the MMI communication session.

If the Motorola SLN2006A MMI Interface Kit is not available, an MMI
cable can be made, refer to Appendix D for more information.

Initiate MMI Communication – For those procedures which require
MMI communication between the LMF and BTS FRUs, follow the
procedures in Table 6-11 to initiate the communication session.

Table 6-11: Establishing MMI Communication

Step Action

1 Connect the LMF computer to the equipment as detailed in the applicable procedure which requires
the MMI communication session. Refer to Figure 6-8 or Figure 6-9 using the GLI3 as an example.

2 If the LMF computer has only one serial port (COM1) and the LMF is running, disconnect the LMF
from COM1 by performing the following:

2a – Click on Tools in the LMF window menu bar, and select Options from the pull–down menu list.
–– An LMF Options dialog box will appear.

2b – In the LMF Options dialog box, click the Disconnect Port button on the Serial Connection tab.

3 Start the named HyperTerminal connection for MMI sessions by double clicking on its Windows
desktop shortcut.

NOTE
If a Windows desktop shortcut was not created for the MMI connection, access the connection from the
Windows Start menu by selecting:

Programs > Accessories > Hyperterminal > HyperTerminal > <Named HyperTerminal
Connection (e.g., MMI Session)>

4 Once the connection window opens, establish MMI communication with the BTS FRU by pressing
the LMF computer <Enter>key until the prompt identified in the applicable procedure is obtained.
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Figure 6-8: LMF Computer Common MMI Connections – Motorola MMI Interface Kit, SLN2006A
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BOARD

(TRN9666A)
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ADAPTER
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FABRICATED MMI CABLE
(SEE MMI CABLE
FABRICATION APPENDIX D)

DB–9
CONNECTOR

8–PIN

LMF COMPUTER
OR EQUIVALENT

To MMI
Connector

COM1
OR

COM2

MMI
Connector

RESET
Button

Figure 6-9: MMI Connection Detail – Fabricated MMI Cable

Online Help

Task oriented online help is available in the LMF by clicking on Help in
the window menu bar, and selecting LMF Help from the pull–down
menu.
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Pinging the BTS

For proper operation, the integrity of the Ethernet LAN A and B links
must be verified. Figure 6-10 represents a typical BTS Ethernet
configuration. The drawing depicts cabling and termination for both the
A and B LANs.

Ping is a program that sends request data packets to hosts on a network,
in this case GLI modules on the BTS LAN, to obtain a response from the
“target” host specified by an IP address.

Follow the steps in Table 6-12 to ping each processor (on both LAN A
and LAN B) and verify LAN redundancy is working properly.

CAUTION Always wear an approved anti–static wrist strap while handling
any circuit card/module to prevent damage by ESD.

SIGNAL
GROUND

SIGNAL
GROUND

50Ω

BIN

SIGNAL
GROUND

50Ω

50Ω

SIGNAL
GROUND

50Ω

SIGNAL
GROUND

CHASSIS GROUND

TERMINATION TERMINATION

AIN

BOUT

 AOUT

SC4812ETL0013–5

Figure 6-10:  BTS Ethernet LAN Termination Diagram

TERMINATION
TERMINATION
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NOTE The Ethernet LAN A and B cables and/or terminations must be
installed on each frame/enclosure external LAN connector before
performing this test. All other processor board LAN connections
are made through the backplanes.

Table 6-12: Pinging the Processors

Step Action

1 If this is a first–time communication with a newly–installed frame or a GLI card which has been
replaced, perform the procedure in Table 11-3 and then return to step 2.

2 Be sure any uncabled LAN A and B IN and OUT connectors at the rear of BTS are terminated with 50
Ω loads.

3 If it has not already been done, connect the LMF computer to the BTS.

4 If it has not already been done, start a GUI LMF session and log into the BTS ( refer to Table 6-7).

5 Remove the 50Ω termination on the BTS LAN B IN connector.

– The LMF session should remain active.

6 Replace the 50Ω termination on the BTS LAN B IN connector.

7 From the Windows desktop, click the Start button and select Run.

8 In the Open box, type ping and the GLI IP address (for example, ping 128.0.0.2).

NOTE
128.0.0.2 is the default IP address for the GLI card in slot GLI–1 in field BTS units.

9 Click on OK.

10 If the targeted module responds, a DOS window will appear with a display similar to the following:

Reply from 128.0.0.2: bytes=32 time=3ms TTL=255

– If the device responds, proceed to step 18.

If there is no response, the following is displayed:

Request timed out

– If the GLI fails to respond, it should be reset and re–pinged. If it still fails to respond, typical
problems would be: failure of the LMF to login, shorted BNC–to–inter-frame cabling, open
cables, crossed A and B link cables, or the GLI itself.

11 Logout of the BTS as described in Table 6-9, exit from the LMF program, and restart the Windows
operating system on the LMF computer.

12 Restart the LMF GUI program as described in LMF Help function on–line documentation, and log into
the BTS as described in Table 6-7.

13 Perform steps 7 through 10 again.

– If the device responds, proceed to step 18.

If there is still no response, proceed to step 14.

. . . continued on next page
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Table 6-12: Pinging the Processors

Step Action

14 If ping was unsuccessful after restarting the LMF computer, press the GLI front panel reset pushbutton
and perform steps 7 through 10 again.

15 After the BTS has been successfully pinged, be sure the 50Ω termination was replaced on the BTS
LAN B IN connector at the rear of the BTS. Disconnect the LMF cable from the front LAN A
connector, and connect it to front LAN B (right–hand connector).

16 Remove the 50Ω termination on the BTS LAN A IN connector.

17 Repeat steps 5 through 9 using LAN B.

18 After the BTS has been successfully pinged on the secondary LAN, replace the 50Ω termination on
the BTS LAN A IN connector.

19 Disconnect the LMF cable from the LAN B and connect it to LAN A.

20 Remove and replace the 50Ω termination on the LAN B IN connector to force the GLI to switch to
primary LAN A.

21 Repeat steps 5 through 9 to ensure proper primary LAN operation.
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Overview

Before a BTS can operate, each equipped device must contain device
initialization (ROM) code. ROM code is loaded in all devices during
manufacture, factory repair, or, for software upgrades, from the CBSC
using the DownLoad Manager (DLM). Device application (RAM) code
and data must be downloaded to each equipped device by the user before
the BTS can be made fully functional for the site where it is installed.

ROM Code

Downloading ROM code to BTS devices from the LMF is NOT routine
maintenance or a normal part of the optimization process. It is only
done in unusual situations where the resident ROM code release level in
the device is not compatible with the required release level of the site
operating software and the CBSC can not communicate with the BTS to
perform the download.

If you must download ROM code, the procedures are located in
Appendix C.

Before ROM code can be downloaded from the LMF, the correct ROM
code file for each device to be loaded must exist on the LMF computer.
ROM code must be manually selected for download.

The ROM code file is not available for GLI3s. GLI3s are
ROM code loaded at the factory.

NOTE

ROM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded will change to
OOS_ROM (blue). The device will remain OOS_ROM (blue) when the
download is completed. A compatible revision–level RAM code must
then be downloaded to the device. Compatible code loads for ROM and
RAM must be used for the device type to ensure proper performance.
The compatible device code release levels for the Base Station System
(BSS) software release being used are listed in the Version Matrix
section of the SCt CDMA Release Notes (supplied on the tape or
CD–ROM containing the BSS software).

RAM Code

Before RAM code can be downloaded from the LMF, the correct RAM
code file for each device must exist on the LMF computer. RAM code
can be automatically or manually selected depending on the Device
menu item chosen and where the RAM code file for the device is stored
in the LMF file structure. The RAM code file will be selected
automatically if the file is in the <x>:\<lmf home
directory>\cdma\loads\n.n.n.n\code folder (where n.n.n.n is the
download code version number that matches the “NextLoad” parameter
of the CDF file). The RAM code file in the code folder must have the
correct hardware bin number for the device to be loaded.
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RAM code can be downloaded to a device that is in any state. After the
download is started, the device being loaded will change to OOS_ROM
(blue). When the download is completed successfully, the device will
change to OOS_RAM (yellow).

When code is downloaded to a GLI, the LMF automatically also
downloads data and then enables the GLI. When enabled, the GLI will
change to INS_ACT (bright green).

For non–GLI devices, data must be downloaded after RAM code is
downloaded. To download data, the device state must be OOS_RAM
(yellow).

If an MCC–DO card is in use, it can only be loaded using the Local
Maintenance Tool (LMT). LMT is software designed specifically for the
MCC–DO card. To avoid confusion and duplication of effort, refer to
Motorola Lifecycles website at
http://www.motorola.com/networkoperators/CDMA–1xEV–DO.htm for
further information on LMT or MCC–DO.

The devices to be loaded with RAM code and data are:

S Group Line Interface III (GLI3)

S Clock Synchronization and Alarm card (CSA) (Only if new revision
code must be loaded)

S Multi–Channel CDMA (MCC–1X) cards

S Broad Band Transceiver (BBX–1X) cards

The GLI must be successfully downloaded with RAM code
and data, and in INS_ACT (bright green) status before
downloading any other device. The RAM code download
process for an GLI automatically downloads data and then
enables the GLI.

NOTE 6
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Verify GLI ROM Code Loads

Devices should not be loaded with a RAM code version which is not
compatible with the ROM code with which they are loaded. Before
downloading RAM code and data to the processor cards, follow the
procedure in Table 6-13 to verify the GLI devices are loaded with the
correct ROM code for the software release used by the Base Station
System.

Prerequisite

Identify the correct GLI ROM code load for the software release being
used on the BSS by referring to the Version Matrix section of the SCt
CDMA Release Notes (supplied on the tapes or CD–ROMs containing
the BSS software).

Table 6-13: Verify GLI ROM Code Loads

Step Action

1 If it has not already been done, start a GUI LMF session and log into the BTS ( refer to Table 6-7).

2 Select all GLI devices by clicking on them, and select Device > Status from the BTS menu bar.

3 In the status report window which opens, note the number in the ROM Ver column for each GLI2.

4 If the ROM code loaded in the GLIs is not the correct one for the software release being used on the
BSS, perform the following:

4a – Log out of the BTS as described in Table 6-9 or Table 6-10, as applicable.

4b – Disconnect the LMF computer.

4c – Reconnect the span lines as described in Table 8-6.

4d – Have the CBSC download the correct ROM code version to the BTS devices.

5 When the GLIs have the correct ROM load for the software release being used, be sure the span lines
are disabled as outlined in Table 6-5 and proceed to downloading RAM code and data.
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Download RAM Code and Data
to GLI

Prerequisites

S Prior to performing these procedures, ensure a code file exists for each
of the devices to be loaded.

S The LMF computer is connected to the BTS (refer to Table 6-6), and
is logged in using the GUI environment (refer to Table 6-7).

Procedure
Follow the procedure in Table 6-14 to download the firmware
application code for GLI. The download code action downloads data and
also enables the GLI.

Table 6-14: Download and Enable GLI Device

n Step Action

1 Note the active LAN to which the LMF computer is connected.

2 At the rear of the BTS, remove the 50–ohm termination from the LAN OUT connector of the
LAN to which the LMF is not connected.

3 Select Tools > Update Next Load > CDMA function to ensure the Next Load parameter is set to
the correct code version level.

4 Note the LAN IP address in the Network Login section of the LMF Login tab, and verify the Win
LMF is logged into the following IP address:

– GLI : 128.0.0.2

5 Down load code to the GLI  by clicking on the GLI.

– From the Device pull down menu, select Download > Code/Data
A status report confirms change in the device status.

– Click OK to close the status window. (The GLI should automatically be downloaded with
data and enabled.)

6 If the card accepts the download and enables, proceed to step 8.

7 If the BTS connection is lost during or after the download process, repeat step 4 and step 5 again.

8 Re–install the 50 ohm termination removed from the LAN connector in step 2.

 

Download RAM Code and Data
to Non–GLI Devices

Downloads to non–GLI devices can be performed individually for each
device or all installed devices can be downloaded with one action.
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CSA devices are RAM code–loaded at the factory. RAM
code is downloaded to CSA only if a newer software
version needs to be loaded.
When downloading to multiple devices, the download may
fail for some of the devices (a time–out occurs). These
devices can be loaded individually after completing the
multiple download.

NOTE

Follow the steps in Table 6-15 to download RAM code and data to
non–GLI devices.

Table 6-15: Download RAM Code and Data to Non–GLI Devices

n Step Action

1 Select the target CSA, MCC, and/or BBX device(s) by clicking on them.

2 Click Device in the BTS menu bar, and select Download > Code/Data in the pull–down menus.

– A status report is displayed that shows the results of the download for each selected device.

3 Click OK to close the status report window when downloading is completed.

NOTE
After a BBX, CSA, or MCC device is successfully loaded with RAM code and data have changed
to the OOS_RAM state (yellow), the status LED should be rapidly flashing GREEN.

NOTE
The command in Step 2 loads both code and data. Data can be downloaded without doing a code
download anytime a device is OOS–RAM using the command in Step 4.

4 To download just the firmware application data to each device, select the target device and select:
Device>Download>Data

 

Selecting CSA Clock Source
and Enabling CSAs

CSA must be enabled prior to enabling the MCCs. Procedures in the
following two sub-sections cover the actions to accomplish this. For
additional information on the CSA sub–system, see “Clock
Synchronization and Alarm (CSA) in the CSA System Time – GPS &
HSO/MSO Verification section of this chapter.

Select CSA Clock Source

A CSA can have three different clock sources. The CSA Source function
can be used to select the clock source for each of the three inputs. This
function is only used if the clock source for a CSA needs to be changed.
The Clock Source function provides the following clock source options.

S Local GPS

S Remote GPS

S HSO/MSO
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Prerequisites
S GLI is INS_ACT (bright green)

S CSA is OOS_RAM (yellow) or INS_ACT (bright green)

Follow the procedure in Table 6-16 to select a CSA Clock Source.

Table 6-16: Select CSA Clock Source

n Step Action

1 Select the CSA for which the clock source is to be selected.

2 Click on Device in the BTS menu bar, and select CSA > Select Clock Source... in the pull–down
menu list.

– A CSA clock reference source selection window will appear.

3 Select the applicable clock source in the Clock Reference Source pick lists. Uncheck the related
check boxes for Clock Reference Sources 2 and 3 if you do not want the displayed pick list item to
be used.

4 Click on the OK button.

– A status report is displayed showing the results of the operation.

5 Click on the OK button to close the status report window.

 

For Local GPS (RF–GPS), verify the CSA configured with
the GPS receiver “daughter board” is installed in the BTS’s
CSA slot before continuing.

NOTE

Enable CSA

Follow the steps outlined in Table 6-17 to enable the CSA.

Table 6-17: Enable CSA

n Step Action

1 Click on Device in the BTS menu bar, and select  Enable in the pull–down menu list.

– A status report is displayed showing the  results of the enable operation.

– Click OK to close the status report window.

* IMPORTANT
– The GPS satellite system satellites are not in a geosynchronous orbit and are maintained and

operated by the United States Department of Defense (DOD). The DOD periodically alters
satellite orbits; therefore, satellite trajectories are subject to change. A GPS receiver that is INS
contains an “almanac” that is updated periodically to take these changes into account.

– If a GPS receiver has not been updated for a number of weeks, it may take up to an hour for the
GPS receiver “almanac” to be updated.

– Once updated, the GPS receiver must track at least four satellites and obtain (hold) a 3–D position
fix for a minimum of 45 seconds before the CSA will come in service. (In some cases, the GPS
receiver needs to track only one satellite, depending on accuracy mode set during the data load).

. . . continued on next page
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Table 6-17: Enable CSA

n ActionStep

NOTE
– After CSA have been successfully enabled, be sure the STA/ALM LED is steady green

(alternating green/red indicates the card is in an alarm state).

2 If more than an hour has passed without the CSA enabling, refer to the CSA System Time – GPS &
HSO/MSO Verification section of this chapter (see Table 6-19, Figure 6-11, and Table 6-20) to
determine the cause.

 

Enable MCCs

This procedure configures the MCC and sets the “tx fine adjust”
parameter. The “tx fine adjust” parameter is not a transmit gain setting,
but a timing adjustment that compensates for the processing delay in the
BTS (approximately 3 mS).

Follow the steps in Table 6-18 to enable the MCCs installed in the CCP2
shelf.

The GLI and primary CSA must be downloaded and
enabled (IN–SERVICE ACTIVE), prior to downloading
and enabling an MCC.

NOTE

Table 6-18: Enable MCCs

n Step Action

1 If the GLI/MCC/BBX view is not displayed in the LMF window, click on the GLI/MCC/BBX area
of the CCP2 shelf.

2 Click on the target MCC(s), or click on Select in the BTS menu bar, and select MCCs in the
pull–down menu list.

3 Click on Device in the BTS menu bar, and select Enable in the pull–down menu list.

– A status report is displayed showing the  results of the enable operation.

4 Click OK to close the status report window.
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Clock Synchronization and
Alarm (CSA) Sub–system
Description

Overview

The primary function of the CSA card is to maintain CDMA system
time. A GPS receiver provides the primary timing reference for all
CDMA BTS’s During normal operation, the CSA clocking outputs are
phase locked to the GPS receiver timing reference. The CSA supports
either an on–board GPS receiver module (RF GPS) or Remote GPS
(RGPS) receiver. The RGPS receiver consists of a combined GPS
receiver and antenna witha digital interface to the CSA.

Backup Timing References

Timing signals from the High Stability Oscillator (HSO) or Medium
Stability Oscillator (MSO) are used in the event that the primary (GPS)
reference should become unavailable.  The HSO or MSO clock is
calibrated against the GPS timing signal when a valid GPS timing signal
is available to provide the longest possible backup timing performance.
The CSA continuously monitors each available timing reference and
utilizes the most suited reference to maintain system synchronization.

Timing Source Fault Management

Fault management has the capability of switching between the GPS
synchronization source and the HSO/MSO backup source in the event of
a GPS receiver failure. During normal operation, the CSA selects GPS as
the primary timing source (Table 6-20). The source selection can also be
overridden via the WinLMF or by the system software.

Front Panel LEDs

The status of the LEDs on the CSA boards are as follows:

S Steady Green – CSA locked to GPS.

S Rapidly Flashing Green – Standby CSA locked to GPS.

S Flashing Green/Rapidly Flashing Red – CSA OOS–RAM attempting
to lock on GPS signal.

S Rapidly Flashing Green and Red – Alarm condition exists. Trouble
Notifications (TNs) are currently being reported to the GLI.
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High Stability Oscillator /
Medium Stability Oscillator
(HSO/MSO)

General

CSA and HSO/MSO

The CSA utilizes timing signals provided by either an HSO or MSO to
maintain BTS synchronization during the absence of valid GPS timing
information. WHen a GPS timing signal is available the CSA is
responsible for calibration of the HSO or MSO clock to maximize the
backup timing interval. A minimum period of 24 hours of operation with
a valid GPS reference is required to fully calibrate the HSO backup
reference such that a 24 hour backup interval may be provided.

HSO

The HSO is a free–running backup oscillator that is capable of providing
a minimum backup interval of 24 hours.

MSO

The MSO is a free–running backup oscillator that is capable of providing
a minimum backup interval of 8 hours.

NOTE Allow the base site and test equipment to warm up for 60
minutes after any interruption in oscillator power. CSA card
warm-up allows the oscillator oven temperature and oscillator
frequency to stabilize prior to test. Test equipment warm-up
allows the Rubidium standard time base to stabilize in frequency
before any measurements are made.
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CSA Frequency Verification

The objective of this procedure is the initial verification of the Clock
Synchronization Alarms (CSA) Module before performing the RF path
verification tests.

Test Equipment Setup 
(GPS & HSO/MSO Verification)

Follow the steps outlined in Table 6-19 to set up test equipment.

Table 6-19: Test Equipment Setup (GPS & HSO/MSO Verification)

Step Action

1 Perform one of the following as required by installed equipment:

1a – Verify a CSA card is installed in the CSA slot, and that the card is INS_ACT (bright green).

2 Connect a serial cable from the LMF COM 1 port (via null modem card) to the MMI port on the CSA
(see Figure 6-11).

3 Start an MMI communication session with the CSA by using the Windows desktop shortcut icon (see
Table 6-11) .

4 When the terminal screen appears press the Enter key until the CSA> prompt appears.

CAUTION If the RF GPS module is uesd to take care to ensure that the GPS
antenna is properly connected to the GPS antenna connector
within the power entry compartment only. Damage to the GPS
antenna and/or GPS receiver can result if the GPS antenna is
inadvertently connected to any other RF connector.
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Figure 6-11: CSA MMI Terminal Connection
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GPS Initialization/Verification

Prerequisites

Ensure the following prerequisites have been met before proceeding:

S The CSA and HSO/MSO (if equipped) has been warmed up for at
least 15 minutes.

S The LMF computer is connected to the MMI port of the CSA as
shown in Figure 6-11.

S An MMI communication session has been started (Table 6-11), and
the CSA> prompt is present in the HyperTerminal window
(Table 6-19).
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Follow the steps outlined in Table 6-20 to initialize and verify proper
GPS receiver functioning.

Table 6-20: GPS Initialization/Verification

Step Action

1 To verify that Clock alarms (0000), Dpll is locked and has a reference source, and
GPS self test passed messages are displayed within the report, issue the following MMI
command

bstatus

– The system will display a response similar to the following:

Clock Alarms (0000):

DPLL is locked and has a reference source.
GPS receiver self test result: passed

Time since reset 0:33:11, time since power on: 0:33:11

2 Enter the following command at the CSA> prompt to display the current status of the GPS receiver and
HSO or MSO backup reference:

sources

– When equipped with HSO, the system will generate a response similar to the following:

N Source Name Type TO Good Status Last Phase Target Phase Valid
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 LocalGPS Primary 4 YES Good 0 0 Yes
1 HSO Backup 4 YES Good –2013177 –2013177 Yes
2 Not Used

*NOTE “Timed–out” should only be displayed while the HSO is warming up. If the HSO does not
appear as one of the sources, then configure the HSO as a back–up source by entering the following
command at the CSA> prompt:

ss 1 12

The HSO or MSO must complete an initial warmup and calibration cycle before being usable as a
backup reference source. The intial warmup cycle should be completed in less than 15 minutes. During
the warmup cycle, the HSO clock output is disabled and indicated as being “timed out” in the
following response to the “sources command:

43:26:15 CSA>sources
43:26:35
43:26:35 N  Source Name    Type        TO   Good   Status  Last Phase   Target Phase  Valid
43:26:35–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
43:26:35 0  Local GPS       Primary      59     Yes      Good          0                   0              Yes
43:26:35 1  HSO                Backup     –25      No       Bad    timed out       unknown         No
43:26:35 2  Not Used   
43:26:35  Current reference source number: 0

See 2–Cont.

. . . continued on next page
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Table 6-20: GPS Initialization/Verification

Step Action

2–
Cont

At the completion of the HSO warmup cycle, the HSO clcok output is enabled allowing califd clock
pulses to be detected by the CSA. An integer value should then be displayed in the HSO “Last Phase”
entry of the “sources” command as show below. If the HSO or MSO calibration cycle is not completed
within 2 hours it will be necessary to inspect the HSO or MSO hardware.

43:29:33 CSA>sources
43:29:43
43:29:43 N  Source Name    Type        TO   Good   Status  Last Phase   Target Phase  Valid
43:29:43 –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 
43:29:43 0  Local GPS       Primary      59     Yes      Good          0                   0              Yes
43:29:43 1  HSO                Backup          3     Yes       Bad    –xxxxxx       –xxxxxx         No
43:29:43 2  Not Used   
43:29:43  Current reference source number: 0

The HSO or MSO calibration cycle can take as long as 2 hours to complete. The completion of the
HSO or MSO calibration is indicated by a “yes” value in the valid column of the “sources” command
response as shown below. If the HSO or MSO calibration cycle is not complete within 2 hours it will
be necessary to inspect the HSO or MSO hardware.

26:09:33 CSA>sources
26:09:35
26:09:35 N  Source Name    Type        TO   Good   Status  Last Phase   Target Phase  Valid
26:09:35 –––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––– 
26:09:35 0  Local GPS       Primary      59     Yes      Good          0                   0              Yes
26:09:35 1  HSO                Backup          3     Yes       Bad    8683466       8683466        Yes
26:09:35 2  Not Used   
26:09:35  Current reference source number: 0

3 HSO information (underlined text above, verified from left to right) is usually the #1 reference source.
If this is not the case, have the OMC–R determine the correct BTS timing source has been identified in
the database by entering the display bts csmgen command and correct as required using the edit
csm csmgen refsrc command.

NOTE
If any of the above areas fail, verify:

– Verify that HSO had been powered up for at least 15 minutes.

– If “timed out” is displayed in the Last Phase column, suspect the HSO output buffer or oscillator
is defective

– Verify the HSO is FULLY SEATED and LOCKED.

4 Verify the following GPS information (underlined text above):

– GPS information is usually the 0 reference source.

– At least one Primary source must indicate “Status = good” and “Valid = yes” to bring site up.

. . . continued on next page
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Table 6-20: GPS Initialization/Verification

Step Action

5 Enter the following command at the CSA> prompt to verify that the GPS receiver is in tracking mode.

gstatus

– Observe the following typical response:

27:27:11 CSA>gstatus
27:27:14 GPS Receiver Control Task State: tracking satellites.
27:27:14  Time since last valid fix: 0 seconds
27:27:14  Frame type (0): master
27:27:14  
27:27:14  Recent Change Data:
27:27:14  GPS time offset 0 ns.
27:27:14  Initial position: lat 151679000 msec, lon: –316798000 msec, height 0 cm
(GPS)
27:27:14  Initial position accuracy (0): estimated.
27:27:14  
27:27:14  GPS Receiver Status
27:27:14  Position hold: lat 151679326 msec, lon: –316798498 msec, hgt 21955 cm
27:27:14  Current position: lat 151679326 msec, lon: –316798498 msec, hgt 21955 cm
(GPS)
27:27:14  8 satellites tracked, receiving 8 satellites, 8 satellites visible.
27:27:14  Current Dilution of Precision (PDOP or HDOP): 0
27:27:14  Date & Time: 2004:03:16:21:37:48 LS:13
27:27:14  GPS Receiver Status Byte:0x8400
27:27:14  Chan:0, SVID: 24, Mode: 8, RSSI: 42, Status: 0x08a1
27:27:14  Chan:1, SVID: 10, Mode: 8, RSSI: 49, Status: 0x08a0
27:27:14  Chan:2, SVID: ––, Mode: –, RSSI: –––, Status: 0x0000
27:27:14  Chan:3, SVID: 21, Mode: 8, RSSI: 48, Status: 0x08a1
27:27:14  Chan:4, SVID: 26, Mode: 8, RSSI:  50, Status: 0x08a0
27:27:14  Chan:5, SVID: 29, Mode: 8, RSSI: 48, Status: 0x08a0
27:27:14  Chan:6, SVID: 18, Mode: 8, RSSI: 42, Status: 0x08a0
27:27:14  Chan:7, SVID: 17, Mode: 8, RSSI: 50, Status: 0x08a0
27:27:14  Chan:8, SVID:  6, Mode: 8, RSSI: 49, Status: 0x08a0
27:27:14  Chan:9, SVID: ––, Mode: –, RSSI: –––, Status: 0x0000
27:27:14  Chan:10, SVID: ––, Mode: –, RSSI: –––, Status: 0x0000
27:27:14  Chan:11, SVID: ––, Mode: –, RSSI: –––, Status: 0x0000
27:27:14

6 Verify the following GPS information (shown above in underlined text):

– At least 4 satellites are tracked, and 4 satellites are visible.

– GPS Receiver Control Task State is “tracking satellites”. Do not continue until this occurs!

– Dilution of Precision indication is not more that 30.

Record the current position base site latitude, longitude, height and height reference (height reference
to Mean Sea Level (MSL) or GPS height (GPS). (GPS = 0   MSL = 1).

. . . continued on next page
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Table 6-20: GPS Initialization/Verification

Step Action

7 If steps 1 through 6 pass, the GPS is good.

NOTE
If any of the above mentioned areas fail, verify that:

– If Initial position accuracy is “estimated” (typical), at least 4 satellites must be tracked and
visible (1 satellite must be tracked and visible if actual lat, log, and height data for this site has
been entered into CDF file).

– If Initial position accuracy is “surveyed,” position data must be  of sufficient accuracy  or
improper GPS receiver timing may occur.

– The GPS antenna is not obstructed or misaligned.

– GPS antenna connector center conductor measureS approximately +5 Vdc with respect to the
shield.

– There is no more than 15 dB of loss between the GPS antenna OSX connector and the BTS frame
GPS input.

– Any lightning protection installed between GPS antenna and BTS frame is installed correctly.

8 Enter the following commands at the CSA> prompt to verify that the CSA is warmed up and that GPS
acquisition has taken place.

debug dpllp 

Observe the following typical response if the CSA is not warmed up (15 minutes from application of
power) (If warmed–up proceed to step 9)

CSA>DPLL Task Wait. 884 seconds left.
DPLL Task Wait. 882 seconds left.
DPLL Task Wait. 880 seconds left.   ...........etc.

NOTE
The warm command can be issued at the MMI port used to force the CSA into warm–up, but the
reference oscillator will be unstable.

9 Observe the following typical response if the CSA is warmed up.

c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175
c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175

10 Verify the following GPS information (underlined text above, from left to right):

– Lower limit offset from tracked source variable is not less than –60 (equates to 3µs limit).

– Upper limit offset from tracked source variable is not more than +60 (equates to 3µs limit).

– TK SRC: 0 is selected, where SRC 0 = GPS.

11 Enter the following commands at the CSA> prompt to exit the debug mode display.

debug  dpllp
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Connecting Test Equipment to
the BTS

The following types of test equipment are required to perform calibration
and ATP tests:

S WinLMF

S Communications system analyzer model supported by the WinLMF

S Power meter model supported by the WinLMF (required when using
the HP 8921A/600 and Advantest R3465 analyzers)

S Non–radiating transmit line termination load

S Directional coupler and in–line attenuator

S RF cables and adapters

Refer to Table 6-21 for an overview of connections for test equipment
currently supported by the WinLMF. In addition, see the following
figures:

S Figure 6-14, Figure 6-15, and Figure 6-16 show the test set
connections for TX calibration

S Figure 6-17 through Figure 6-20 show the test set connections for
optimization/ATP tests

Test Equipment GPIB Address
Settings

All test equipment is controlled by the WinLMF through an
IEEE–488/GPIB bus. To communicate on the bus, each piece of test
equipment must have a GPIB address set which the WinLMF will
recognize. The standard address settings used by the WinLMF for the
various types of test equipment items are as follows:

S Signal generator address:  1

S Power meter address:  13

S Communications system analyzer:  18

Using the procedures included in the Verifying and Setting GPIB
Addresses section of Appendix B, verify and, if necessary, change the
GPIB address of each piece of employed test equipment to match the
applicable addresses above.

Supported Test Equipment

CAUTION To prevent damage to the test equipment in high power
configurations, all transmit (TX) test connections must be
through a 30 dB directional coupler plus a 20 dB in-line
attenuator for the 800 MHz BTSs.
Attenuators are not required for low power configurations.

IS–95A/B Operation
Optimization and ATP testing for IS–95A/B sites or carriers may be
performed using the following test equipment:
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S CyberTest (High Power Configurations only)

S Advantest R3267 spectrum analyzer with R3562 signal generator

S Advantest R3465 spectrum analyzer with R3561L signal generator
and HP–437B or Gigatronics Power Meter

S Agilent E4406A transmitter test set with E4432B signal generator

S Agilent 8935 series E6380A communications test set (formerly HP
8935)

S Hewlett–Packard HP 8921 (with CDMA interface and, for 1.9 GHz,
PCS Interface) and HP–437B or Gigatronics Power Meter

S Spectrum Analyzer (HP8594E) – optional

S Rubidium Standard Timebase – optional

CDMA2000 1X Operation
Optimization and ATP testing for CDMA2000 1X sites or carriers may
be performed using the following test equipment:

S Advantest R3267 spectrum analyzer with R3562 signal generator

S Agilent E4406A transmitter test set with E4432B signal generator

S Agilent 8935 series E6380A communications test set (formerly HP
8935) with option 200 or R2K and with E4432B signal generator for
1X FER

S Agilent E7495A communications test set

Test Equipment Preparation

See Appendix B for specific steps to prepare each type of test set and
power meter to perform calibration and ATP.

Agilent E7495A communications test set requires additional setup and
preparation. This is described in detail in Appendix B.
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Test Equipment Connection
Charts

To use the following charts to identify necessary test equipment
connections, locate the communications system analyzer being used in
the COMMUNICATIONS SYSTEM ANALYZER columns, and read down
the column. Where a dot appears in the column, connect one end of the
test cable to that connector. Follow the horizontal line to locate the end
connection(s), reading up the column to identify the appropriate
equipment and/or BTS connector.

IS–95A/B–only Test Equipment Connections
Table 6-21 depicts the interconnection requirements for currently
available test equipment supporting IS–95A/B only which meets
Motorola standards and is supported by the WinLMF.

Table 6-21: IS–95A/B–only Test Equipment Interconnection
COMMUNICATIONS SYSTEM ANALYZER ADDITIONAL TEST EQUIPMENT

SIGNAL Cyber–Test
Advantest

R3465 HP 8921A
HP 8921
W/PCS

Power
Meter

GPIB
Interface

WinL
MF

Attenuator
&

Directional
Coupler BTS

EVEN SECOND
SYNCHRONIZATION

EVEN
SEC REF

EVEN SEC
SYNC IN

EVEN
SECOND
SYNC IN

EVEN
SECOND
SYNC IN

19.6608 MHZ
CLOCK

TIME
BASE IN

CDMA
TIME BASE

IN

CDMA
TIME BASE

IN

CDMA
TIME BASE

IN

CONTROL
IEEE 488 BUS

IEEE
488 GPIB GPIB

SERIAL
PORTHP–I

B
HP–IB

TX TEST
CABLES

RF
IN/OUT

INPUT
50W TX1–6

RF
IN/OUT

RF
IN/OUT

20 DB
ATTEN.

BTS
PORT

RX TEST
CABLES

RF
GEN OUT

RF OUT
50W RX1–6

DUPLEX
OUT

RF OUT
ONLY

SYNC
MON-
ITOR

FREQ
MON-
ITOR

HP–IB
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CDMA2000 1X/IS–95A/B–capable Test Equipment
Connections
Table 6-22 depicts the interconnection requirements for currently
available test equipment supporting both CDMA 2000 1X and
IS–95A/B which meets Motorola standards and is supported by the
WinLMF.

Table 6-22: CDMA2000 1X/IS–95A/B Test Equipment Interconnection
COMMUNICATIONS SYSTEM

ANALYZER ADDITIONAL TEST EQUIPMENT

SIGNAL

Agilent
8935

(Option
200 or
R2K)

Advantest
R3267

Agilent
E4406A

Agilent
E4432
Signal
Gen.

Advantest
R3562
Signal

Generator
Power
Meter

GPIB
Interface LMF

Attenuator
&

Directional
Coupler BTS

EVEN SECOND
SYNCHRONIZATION

EVEN
SECOND
SYNC IN

EXT TRIG
IN

19.6608 MHZ
CLOCK

EXT REF
IN

MOD TIME
BASE IN

CONTROL
IEEE 488 BUS

10 MHZ
OUT

GP–IBHP–IB GP–IB GPIB
SERIAL
PORTGPIB GPIB

TX TEST
CABLES

RF
IN/OUT

INPUT
50 W TX1–6

20 DB
ATTEN.

BTS
PORT

SYNC
MONITOR

FREQ
MONITOR

HP–IB

PATTERN
TRIG IN

EXT REF
IN

RF INPUT
50 W

RX TEST
CABLES

RF OUT
50 W

RF OUTPUT
50 W RX1–6

10 MHZ
10 MHZ OUT
(SWITCHED)

SYNTHE 
REF IN

10 MHZ
IN

TRIGGER
INEXT TRIG

SIGNAL SOURCE
CONTROLLED

SERIAL I/O

SERIAL
I/O

SERIAL
I/O

10 MHZ
REF OUT

*  WHEN USED ALONE, THE AGILENT 8935 WITH OPTION 200 OR R2K SUPPORTS IS–95A/B RX TESTING BUT NOT CDMA2000 1X RX TESTING.

*
RF

IN/OUT
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Equipment Warm-up

Warm-up BTS equipment for a minimum of 60 minutes
prior to performing the BTS optimization procedure. This
assures BTS stability and contributes to optimization
accuracy.

– Time spent running initial or normal power-up,
hardware/firmware audit, and BTS download counts
as warm-up time.

IMPORTANT

*

Before installing any test equipment directly to any BTS
TX OUT connector, verify there are no CDMA channels
keyed.

– At active sites, have the OMC-R/CBSC place the
antenna (sector) assigned to the BBX under test OOS.
Failure to do so can result in serious personal injury
and/or equipment damage.

WARNING

Automatic Cable Calibration
Set–up

Figure 6-19 and Figure 6-20 show the cable calibration setup for the test
sets supported by the WinLMF. The left side of the diagram depicts the
location of the input and output connectors of each test equipment item,
and the right side details the connections for each test. Table 6-24
provides a procedure for performing automatic cable calibration.

Manual Cable Calibration

If manual cable calibration is required, refer to the procedures in
Appendix B.
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ÎÎÎ
ÎÎÎÏ

Motorola CyberTest

Advantest Model R3465

RF OUT 50Ω

INPUT 50Ω

RF GEN OUTANT IN

SUPPORTED TEST SETS

100–WATT  (MIN)
NON–RADIATING

RF LOAD

TEST
SET

A. SHORT CABLE CAL

SHORT
CABLE

B. RX TEST CAL SETUP

TEST
SET

C. TX TEST AND RX TEST CAL SETUP

20 DB IN–LINE
ATTENUATOR

CALIBRATION SET UP

N–N FEMALE
ADAPTER

TX
CABLE

SHORT
CABLE

Note: The 30 dB directional coupler is not used
with the Cybertest test set. The TX cable is
connected directly to the Cybertest test set.

A 10dB attenuator must be used with the short test
cable for cable calibration with the CyberTest test
set. The 10dB attenuator is used only for the cable
calibration procedure, not with the test cables for
TX calibration and ATP tests.

TEST
SET

RX
CABLE

SHORT
CABLE

DIRECTIONAL
COUPLER 
(30 DB)

N–N FEMALE
ADAPTER

50 Ω
ΤERM.

Figure 6-12: IS–95A/B and CDMA 2000 1X Cable Calibration Test Setup –
Agilent E4406A/E4432B and Advantest R3267/R3562

Á
Á
ÁÁ
ÁÁÁÁÁÁ
Á
Á
Á
ÁÁÁÁÁ

Agilent 8935 Series E6380A
(formerly HP 8935)

RF
IN/OUT

ANT
IN

Hewlett Packard Model HP 8921A

Note: For 800 MHZ only. The HP8921A cannot
be used to calibrate cables for PCS frequencies.

TX CABLE FOR
TX TEST CABLE
CALIBRATION

RX CABLE FOR
DRDC RX TEST
CABLE CALIBRATION

DUPLEX
OUT

ANT
IN
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TEST
SET

A. SHORT CABLE CAL

SHORT
CABLE

B. RX TEST SETUP

CALIBRATION SET UP

TEST
SET

RX
CABLE

SHORT
CABLE

N–N FEMALE
ADAPTER

Figure 6-13: IS–95A/B and CDMA 2000 1X Cable Calibration Test Setup – Agilent E4406A/E4432B
and Advantest R3267/R3562

SUPPORTED TEST SETS

INPUT 50 Ω

RF OUT
50 Ω

Advantest R3267 (Top) and R3562 (Bottom)

NOTE:

SYNTHE REF IN ON REAR OF SIGNAL GENERATOR IS
CONNECTED TO 10 MHZ OUT ON REAR OF SPECTRUM
ANALYZER

Agilent E4432B (Top) and E4406A (Bottom)

NOTE:

10 MHZ IN ON REAR OF SIGNAL GENERATOR IS CONNECTED TO
10 MHZ OUT (SWITCHED) ON REAR OF TRANSMITTER TESTER
(FIGURE B-18).

RF INPUT
50 Ω

RF OUTPUT
50 Ω

100–WATT  (MIN)
NON–RADIATING

RF LOAD

TEST
SET

D. TX TEST SETUP AND RX TEST SETUP

20 DB IN–LINE
ATTENUATOR

N–N FEMALE
ADAPTER

TX
CABLE

SHORT
CABLE

DIRECTIONAL
COUPLER 
(30 DB)

50 Ω
ΤERM.

TX CABLE FOR
TX TEST CABLE
CALIBRATION

RX CABLE FOR
DRDC RX TEST
CABLE CALIBRATION
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Set-up for TX Calibration

Figure 6-14 and Figure 6-15 show the test set connections for TX
calibration.

Figure 6-14: TX Calibration Test Setup –
CyberTest (IS–95A/B) and Agilent 8935 (IS–95A/B and CDMA2000 1X)

ÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁ
ÁÁÁÁ

Motorola CyberTest

Agilent 8935 Series E6380A (formerly HP 8935)

TEST SETS TRANSMIT (TX) SET UP

ÎÎÎ
ÎÎÎ
ÎÎÎÏ

FRONT PANEL RF
IN/OUT

RF
IN/OUT

HP–IB
TO GPIB
BOX

NOTE: THE 30 DB DIRECTIONAL COUPLER IS NOT
USED WITH THE CYBERTEST TEST SET. THE TX
CABLE IS CONNECTED DIRECTLY TO THE
CYBERTEST TEST SET.

RS232–GPIB
INTERFACE BOX

GPIB
CABLE

RS232 NULL
MODEM
CABLE

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

BTS

CDM
WinLMF

DIP SWITCH SETTINGS

LAN
B

LAN
A

GPIB

RF IN/OUT

FREQ
MONITOR

SYNC
MONITOR

CSA

Communications
System Analyzer

0–20 DB
IN–LINE
ATTENUATOR

50 Ω
TERM
.

TX TEST
CABLE

DIRECTIONAL
COUPLER
(30 DB)

100–WATT (MIN.)
NON–RADIATING

RF LOAD

TX TEST
CABLE

* BLACK RECTANGLES
REPRESENT THE RAISED
PART OF SWITCHES

Power Meter
(OPTIONAL)*

POWER
SENSOR

* A POWER METER CAN BE USED IN
PLACE OF THE COMMUNICATIONS
TEST SET FOR TX CALIBRATION/
AUDIT

NOTE:
TO PERFORM LOW POWER CALIBRATION
THE POWER METER IS ADEQUATE FOR
MEASUREMENT PURPOSES WITHOUT
USING THE 30 DB DIRECTIONAL COUPLER
AND 0–20 DB ATTENUATOR.

IF THE AGILENT 8935 MUST BE USED,
THEN CONNECT TO THE ANT IN PORT.

ANT
IN

cCLPA

ANTENNA
CONNECTOR

TX IN
CONNECTOR

RX OUT
CONNECTOR

TX 1RX DIV

LOW POWER
CONNECTION

HIGH POWER
CONNECTION
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Figure 6-15: TX Calibration Test Setup – Using Power Meter

TEST SETS TRANSMIT (TX) SET UP

NOTE: 
THE HP8921A AND ADVANTEST R3465
CANNOT BE USED FOR TX CALIBRATION. A
POWER METER MUST BE USED.

RS232–GPIB
INTERFACE BOX

GPIB
CABLE

RS232 NULL
MODEM
CABLE

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

BTS

CDMA
WinLMF

DIP SWITCH SETTINGS

LAN
B

LAN
A

FREQ
MONITOR

SYNC
MONITOR

CSA

50 Ω
TERM
.

TX TEST
CABLE

DIRECTIONAL
COUPLER
(30 DB)

100–WATT (MIN.)
NON–RADIATING

RF LOAD

TX TEST
CABLE

* BLACK RECTANGLES
REPRESENT THE RAISED
PART OF SWITCHES

POWER
SENSOR Power  Meter

0–20 DB IN–LINE
ATTENUATOR

NOTE:
TO PERFORM LOW POWER CALIBRATION
THE 30 DB DIRECTIONAL COUPLER AND 
0–20 DB ATTENUATOR ARE NOT REQUIRED.

ANT
IN

Hewlett Packard Model HP 8921A
(for 800 MHz)

NOTE:
TO PERFORM LOW POWER CALIBRATION
USING THE HP8921A, CONNECT TO THE
ANT IN PORT. THE 30 DB DIRECTIONAL
COUPLER AND 0–20 DB ATTENUATOR ARE
NOT REQUIRED.

cCLPA

ANTENNA
CONNECTOR

TX IN
CONNECTOR

RX OUT
CONNECTOR

TX 1RX DIV

LOW POWER
CONNECTION

HIGH POWER
CONNECTION
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Figure 6-16: TX Calibration Test Setup – 
Agilent E4406A and Advantest R3567 (IS–95A/B and CDMA2000 1X)

TEST SETS TRANSMIT (TX) SET UP

RS232–GPIB
INTERFACE BOX

GPIB
CABLE

RS232 NULL
MODEM
CABLE

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

BTS

CDMA
WinLMF

DIP SWITCH SETTINGS

LAN
B

LAN
A

GPIB

RF INPUT 50 Ω
OR INPUT 50 Ω

FREQ
MONITOR

SYNC
MONITOR

CSA

Communications
SystemAanalyzer

50 Ω
TERM
.

TX TEST
CABLE

DIRECTIONAL
COUPLER
(30 DB)

100–WATT (MIN.)
NON–RADIATING

RF LOAD

TX TEST
CABLE

* BLACK RECTANGLES
REPRESENT THE RAISED
PART OF SWITCHES

NOTE:  IF BTS IS EQUIPPED
WITH DRDCS (DUPLEXED
RX/TX SIGNALS), CONNECT
THE TX TEST CABLE TO
THE DRDC ANTENNA
CONNECTOR.

POWER
METER

(OPTIONAL)*

POWER
SENSOR

* A POWER METER CAN BE USED IN
PLACE OF THE COMMUNICATIONS
TEST SET FOR TX CALIBRATION/
AUDIT

RF INPUT
50 Ω

Agilent E4406A

INPUT 50 Ω

Advantest R3267

0–20 DB
IN–LINE
ATTENUATOR

NOTE:
TO PERFORM LOW POWER CALIBRATION THE POWER
METER IS ADEQUATE FOR MEASUREMENT PURPOSES
WITHOUT USING THE 30 DB DIRECTIONAL COUPLER AND
0–20 DB ATTENUATOR.

cCLPA

ANTENNA
CONNECTOR

TX IN
CONNECTOR

RX OUT
CONNECTOR

TX 1RX DIV

HIGH POWER
CONNECTION

LOW POWER
CONNECTION TO

EITHER THE
POWER METER
OR ANALYZER
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Set–up for ATP
Figure 6-17 and Figure 6-18 show the test set connections for ATP tests.

Figure 6-17: IS–95A/B ATP Test Set–up– 
CyberTest, Advantest R3465, and Agilent 8935

Motorola CyberTest

TEST SETS Optimization/ATP SET UP

ÎÎÎÎ
ÎÎÎÎ
ÎÎÎÎÏ

RF
IN/OUT

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSA CARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSA CARD

Advantest Model R3465

INPUT 50Ω

GPIB CONNECTS
TO BACK OF UNIT

NOTE: The 30 dB directional coupler is not
used with the Cybertest test set. The TX
cable is connected directly to the Cybertest
test set.

RF OUT 50Ω

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSA CARD

RF GEN
OUT

SYNC MONITOR EVEN
SEC TICK PULSE
REFERENCE FROM CSA
CARD

BNC
“T”

TO EXT TRIGGER CONNECTOR
ON REAR OF TEST SET
(FOR DETAILS, SEE
FIGURE B-15)

RS232–GPIB
INTERFACE BOX

GPIB
CABLE

RS232 NULL
MODEM
CABLE

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

BTS CDMA
WinLMF

DIP SWITCH SETTINGS

LAN
B

LAN
A

RX TEST
CABLE

GPIB

RF IN/OUT
OR
INPUT 50 Ω

RF GEN OUT,
RF OUT 50Ω,
OR RF IN/OUT

FREQ
MONITOR

SYNC
MONITOR

CSA

50 Ω
TERM
.

TX TEST
CABLE

DIRECTIONAL
COUPLER
(30 DB)

100–WATT (MIN.)
NON–RADIATING

RF LOAD

TX TEST
CABLE

* BLACK RECTANGLES
REPRESENT THE RAISED
PART OF SWITCHES

EXT
REF IN

EVEN
SECOND/
SYNC IN

NOTE:  IF BTS IS EQUIPPED
WITH DRDCS (DUPLEXED RX/TX
SIGNALS), BOTH THE TX AND RX
TEST CABLES CONNECT TO THE
DRDC ANTENNA CONNECTOR.
(SEE FIGURE 6-20.)

0–20 DB IN–LINE
ATTENUATOR

IMPORTANT:
WHEN PERFORMING LOW POWER TESTING BYPASS THE COUPLER AND
ATTENUATOR AND CONNECT DIRECTLY TO THE ANALYZER.

ÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Agilent 8935 Series E6380A (formerly HP 8935)

RF IN/OUT

HP–IB
TO GPIB
BOX

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSA CARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSA CARD

10 MHZ
REF OUT

Communications
System Analyzer

ANT
IN

cCLPA

ANTENNA

TX INRX OUT

RX MAINRX DIV TX1

HIGH POWER
CONNECTION
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Figure 6-18: IS–95A/B ATP Test Setup – HP 8921A

RF OUT
ONLY

Hewlett Packard Model HP 8921A W/PCS Interface
(for  1900 MHz)

GPIB
CONNECTS
TO BACK OF

UNITS

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSA CARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSA CARD

TEST SETS Optimization/ATP SET UP

RF
IN/OUT

GPIB
CONNECTS
TO BACK OF

UNIT

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSA CARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSA CARD

Hewlett Packard Model HP 8921A
(for 800 MHz)

RF
IN/OUT

DUPLEX
OUT

RS232–GPIB
INTERFACE BOX

GPIB
CABLE

RS232 NULL
MODEM
CABLE

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

BTS CDMA
WinLMF

DIP SWITCH SETTINGS

LAN
B

LAN
A

RX TEST
CABLE

GPIB

PCS INTERFACE
INPUT/OUTPUT

PORTS

FREQ
MONITOR

SYNC
MONITOR

CSA

50 Ω
TERM
.

TX TEST
CABLE

DIRECTIONAL
COUPLER
(30 DB)

100–WATT (MIN.)
NON–RADIATING

RF LOAD

TX TEST
CABLE

* BLACK RECTANGLES
REPRESENT THE RAISED
PART OF SWITCHES

EXT
REF IN

EVEN
SECOND/
SYNC IN

HP PCS
INTERFACE*

0–20 DB IN–LINE
ATTENUATOR

* FOR 1900 MHZ
ONLY

RF OUT ONLY

RF IN/OUT

NOTE:

FOR 800 MHZ TESTING, CONNECT CABLES TO THE
HP 8921A AS FOLLOWS:

RX TEST CABLE TO DUPLEX OUT

TX TEST CABLE TO RF IN/OUT

Communications
System Analyzer

ANT
IN

cCLPA

ANTENNA

TX INRX OUT

RX MAINRX DIV TX1

Signal
Generator
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TEST SETS Optimization/ATP SET UP

Figure 6-19: IS–95A/B and CDMA2000 1X ATP Test Setup Agilent Test Equipment

RF INPUT
50 Ω

RF
OUTPUT

50 Ω

Agilent E4432B (Top) and E4406A (Bottom)

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSA CARD

SYNC MONITOR
EVEN SEC TICK
PULSE REFERENCE
FROM CSA CARD

BNC
“T”

TO TRIGGER IN
ON REAR OF
TRANSMITTER
TESTER

TO PATTERN TRIG IN
ON REAR OF SIGNAL
GENERATOR

TO EXT REF IN 
ON REAR OF
TRANSMITTER
TESTER 

NOTE:

10 MHZ IN ON REAR OF SIGNAL GENERATOR IS CONNECTED TO
10 MHZ OUT (SWITCHED) ON REAR OF TRANSMITTER TESTER
(SEE FIGURE B-18).

RS232–GPIB
INTERFACE BOX

GPIB
CABLE

RS232 NULL
MODEM
CABLE

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

BTS

CDMA
LMF

DIP SWITCH SETTINGS *

LAN
B

LAN
A

Communications
System Analyzer

HP–IB
OR

GPIB

FREQ
MONITOR

SYNC
MONITOR

CSM

BTS
CPLD

ANTENNA

Signal
Generator

GPIB

10 MHZ
IN

10 MHZ
REF OUT

OR
10 MHZ

OUT
TRIGGER IN

OR
EVEN SEC
SYNCH IN

EXT
REF
IN

BNC
“T”

PATTERN
TRIG IN

* BLACK RECTANGLES
REPRESENT THE RAISED
PART OF SWITCHES

RX TEST
CABLE

50 Ω
TERM
.

TX TEST
CABLE

DIRECTIONAL
COUPLER
(30 DB)

100–WATT (MIN.)
NON–RADIATING

RF LOAD

TX TEST
CABLE

2O DB IN–LINE
ATTENUATOR

RF IN/OUT
OR
RF INPUT
50 Ω

RF OUTPUT 50 ΩAgilent  E4432B (Top) and 8935 Series E6380A
(Bottom)

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSA CARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSA CARD

ÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁÁÁÁÁ

RF
OUTPUT

50 Ω

NOTES:

10 MHZ IN ON REAR OF SIGNAL GENERATOR IS CONNECTED TO
10 MHZ REF OUT ON SIDE OF CDMA BASE STATION TEST SET 

PATTERN TRIG IN ON REAR OF SIGNAL GENERATOR IS
CONNECTED TO EVEN SECOND SYNC IN ON SIDE OF CDMA BASE
STATION TEST SET.

(SEE FIGURE B-17)

RF IN/OUTBNC
“T”

RX OUT TX IN

cCLPA

RX MAIN TX1

6



Test Equipment Setup  – continued

 6-64 1X SC480 BTS Hardware Installation, Optimization/ATP, and FRU MAY 2004

PRELIMINARY

Figure 6-20: IS–95A/B and CDMA2000 1X Optimization/ATP Test Setup – Agilent E4432B/8935 Series
E6380A and E4432B/E4406A Test Equipment
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Background

Proper test equipment calibration helps to ensure accurate BTS
optimization and acceptance testing by assuring that the test equipment
and associated cables do not introduce measurement errors.

If the test equipment set being used to optimize or test the
BTS has been calibrated and maintained as a set, this
procedure does not need to be performed.

NOTE

This procedure must be performed prior to beginning the optimization.
Verify all test equipment (including all associated cables and adapters
actually used to interconnect test equipment items and the BTS) has been
calibrated and maintained as a set.

If any piece of test equipment, test cable, or RF adapter
that makes up the calibrated test equipment set has been
replaced, the set must be re-calibrated. Failure to do so can
introduce measurement errors, resulting in incorrect
measurements and degradation to system performance.
Motorola recommends repeating cable calibration before
testing at each BTS site.

CAUTION

Calibration of the communications system analyzer (or
equivalent test equipment) must be performed at the site
before calibrating the overall test equipment set. Calibrate
the test equipment after it has been allowed to warm–up
and stabilize for a a minimum of 60 minutes.

NOTE

Calibration Procedures
Included

Automatic

Procedures included in this section use the WinLMF automated
calibration routine to determine path losses of the supported
communications analyzer, power meter, associated test cables, adapters,
and (if used) antenna switch that make up the overall calibrated test
equipment set. After calibration, the gain/loss offset values are stored in
a test measurement offset file on the WinLMF computer.
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Manual

Agilent E4406A Transmitter Tester – The E4406A does not support
the power level zeroing calibration performed by the WinLMF. If this
instrument is to be used for Bay Level Offset calibration and calibration
is attempted with the WinLMF Calibrate Test Equipment function, the
WinLMF will return a status window failure message stating that zeroing
power is not supported by the E4406A. Refer to the Equipment
Calibration section of Appendix B for instructions on using the
instrument’s self–alignment (calibration) function prior to performing
Bay Level Offset calibration.

Power Meters – Manual power meter calibration procedures to be
performed prior to automated calibration are included in the Equipment
Calibration section of Appendix B .

Cable Calibration – Manual cable calibration procedures using the HP
8921A and Advantest R3465 communications system analyzers are
provided in the Manual Cable Calibration section of Appendix B, if
needed.

GPIB Addresses

GPIB addresses can range from 1 through 30. The WinLMF will accept
any address in that range, but the numbers entered in the WinLMF
Options window GPIB address boxes (Table 6-23 and Table 6-24) must
match the addresses set in the test equipment. Motorola recommends
using 1 for a CDMA signal generator, 13 for a power meter, and 18 for a
communications system analyzer. To verify and, if necessary, change the
GPIB addresses of the test equipment, refer to the Setting GPIB
Addresses section of Appendix B.

Selecting Test Equipment

Serial Connection and Network Connection tabs are provided in the
WinLMF Options window to specify the test equipment connection
method. The Serial Connection tab is used when the test equipment
items are connected directly to the WinLMF computer through a GPIB
box (normal setup). The Network Connection tab is used when the test
equipment is to be connected remotely via a network connection or the
Agilent E7495A Communications Test Set is used.

Prerequisites

Be sure the following have been completed before selecting test
equipment:

S Test equipment is correctly connected and turned on.

S GPIB addresses set in the test equipment have been verified as correct
using the applicable procedures in Appendix B.

S WinLMF computer serial port and test equipment are connected to the
GPIB box.
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Selecting Test Equipment

Test equipment may be selected either manually with operator input or
automatically using the WinLMF autodetect feature.

Manually Selecting Test
Equipment in a Serial
Connection Tab

Test equipment can be manually specified before or after the test
equipment is connected. The WinLMF does not attempt to verify the test
equipment is actually detected when manual selection is specified.
Follow the procedure in Table 6-23 to manually select test equipment.

Table 6-23: Procedure for Selecting Test Equipment Manually in the Serial Connection Tab

Step Action

1 In the WinLMF window menu bar, click Tools and select Options... from the pull–down menu.

The WinLMF Options window appears.

2 If it is not in the forefront, click on the Serial Connection tab.

3 Select the correct serial port in the COMM Port: pick list (normally COM1).

4 If it is not selected (black dot showing), click on the Manual Specification button.

5 Click on the check box(es) corresponding to the test equipment item(s) to be used.

6 Type the GPIB address in the corresponding GPIB address box (refer to the Setting GPIB Addresses
section of Appendix B for directions on verifying and/or changing test equipment GPIB addresses).

Motorola–recommended addresses are:

1 = signal generator

13 = power meter

18 = communications system analyzer

* IMPORTANT
When test equipment items are manually selected by the operator, the WinLMF defaults to using a
power meter for RF power measurements. The WinLMF will use a communications system analyzer
for RF power measurements only if a power meter is not selected (power meter checkbox not
checked).

7 Click on Apply. (The button will darken until the selection has been committed.)

NOTE
With manual selection, the WinLMF does not attempt to detect the test equipment to verify it is
connected and communicating with the WinLMF.

To verify and, if necessary, change the GPIB address of the test equipment, refer to Appendix B.

8 Click on Dismiss to close the WinLMF Options window.
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Automatically Selecting Test
Equipment in the Serial
Connection Tab

When using the auto-detection feature to select test equipment, the
WinLMF determines which test equipment items are actually
communicating with WinLMF. Follow the procedure in Table 6-24 to
use the auto-detection feature.

Table 6-24: Procedure for Selecting Test Equipment Using Auto-Detect

Step Action

1 In the WinLMF window menu bar, click Tools and select Options... from the pull–down menu. The
WinLMF Options window appears.

2 If it is not in the forefront, click on the Serial Connection tab.

3 Select the correct serial port in the COMM Port: pick list (normally COM1).

4 If it is not selected (no black dot showing), click on the Auto–Detection button.

5 If they are not already displayed in the box labeled GPIB address to search, click in the box and type
in the GPIB addresses for the test equipment to be used, separating each address with commas and no
spaces. (Refer to the Setting GPIB Addresses section of Appendix B for instructions on verifying
and/or changing test equipment GPIB addresses.)

NOTE
During the GPIB address search for a test equipment item to perform RF power measurements (that is,
for TX calibration), the WinLMF will select the first item it finds with the capability to perform the
measurement. If, for example, the address sequence 13,18,1 is included in the GPIB addresses to
search box, the power meter (GPIB address 13) will be used for RF power measurements. If the
address sequence 18,13,1 is included, the WinLMF will use the communications system analyzer
(GPIB address 18) for power measurements.

6 Click Apply. The button will darken until the selection has been committed. A check mark will appear
in the applicable Manual Configuration section check boxes for detected test equipment items.

7 Click Dismiss to close the WinLMF Options window.

  

Calibrating Test Equipment

The WinLMF Calibrate Test Equipment function zeros the power
measurement level of the test equipment item that is to be used for TX
calibration and audit. If both a power meter and an analyzer are
connected (for example, an HP 437 and an HP8921A/600), only the
power meter is zeroed.

The Agilent E4406A transmitter tester does not support
power measurement level zeroing. Refer to the Equipment
Calibration section of Appendix B for E4406A calibration.

NOTE
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Prerequisites

S WinLMF computer serial port and test equipment are connected to the
GPIB box.

S Test equipment is turned on and has warmed up for at least 60
minutes.

S Test equipment has been selected in the WinLMF (Table 6-23 or
Table 6-24)

Follow the procedure in Table 6-25 to calibrate the test equipment.

Table 6-25: Procedure for Test Equipment Calibration

Step Action

1 From the Util menu, select Calibrate Test Equipment from the pull–down menu. A Directions
window is displayed.

2 Follow the directions provided.

3 Click on Continue to close the Directions window and start the calibration process. A status report
window is displayed.

4 Click on OK to close the status report window.

  

Calibrating Cables Overview

The WinLMF Cable Calibration function is used to measure the path
loss (in dB) for the TX and RX cables, adapters, directional couplers,
and attenuators that make up the cable configurations used for testing. A
communications system analyzer is used to measure the loss of both the
TX test cable and the RX test cable configurations. WinLMF cable
calibration consists of the following processes:

1. Measure the loss of a short cable. This is done to compensate for any
measurement error of the communications system analyzer. The
short cable, which is used only for the calibration process, is
connected in series with both the TX and RX test cable
configurations when they are measured. The measured loss of the
short cable is deducted from the measured loss of the TX and RX
test cable configurations to determine the actual loss of the
configurations. This deduction is done so any error in the analyzer
measurement will be adjusted out of both the TX and RX
measurements.

2. Measure the loss of the short cable plus the RX test cable
configuration. The RX test cable configuration normally consists
only of a coax cable with type–N connectors that is long enough to
reach from the BTS RX connector to the test equipment. When the
BTS antenna connectors carry duplexed TX and RX signals, a
directional coupler and, if required by BTS type, an additional
attenuator are also required for the RX test cable configuration.
These additional items must be included in the path loss
measurement.
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3. Measure the loss of the short cable plus the TX test cable
configuration. The TX test cable configuration normally consists of
two coax cables with type–N connectors, a directional coupler, a
termination load with sufficient rating to dissipate the BTS output
power, and an additional attenuator, if required by the BTS type. The
total path loss of the TX test configuration must be as required for
the BTS (normally 30 or 50 dB). The Motorola Cybertest analyzer is
different from other communications system analyzers because the
required attenuation/load is built into the test set. Because of this,
the Cybertest TX test configuration consists only of the required
length coax cable.

Calibrating Test Cable
Configurations with a
Communications System
Analyzer

Cable Calibration is used to calibrate both TX and RX test cables.

WinLMF cable calibration cannot be accomplished with an
HP8921A analyzer for 1.9 GHz. A different analyzer type
or the signal generator and spectrum analyzer method
(Table 6-27 and Table 6-28) must be used. Cable
calibration values must be manually entered into the
WinLMF cable loss file if the signal generator and
spectrum analyzer method is used. To use the HP8921A for
manual test cable configuration calibration for 800 MHz
BTSs, refer to the Manual Cable Calibration section of
Appendix B.

NOTE

Prerequisites
S Test equipment is turned on and has warmed up for at least 60

minutes. Agilent E7495A requires only 30 minute warmup.

S Test equipment has been selected in the WinLMF (Table 6-23 or
Table 6-24).

S Test equipment has been calibrated and correctly connected for the
type of test cable configuration to be  calibrated.

Calibrating cables

Refer to Figure 6-19 or Figure 6-20 and follow the procedure in
Table 6-26 to calibrate the test cable configurations.

Table 6-26: Procedure to Test Cabling Calibration using Communication System Analyzer

n Step Action

1 Click Util in the BTS menu bar, and select Cable Calibration... in the pull–down menu. A Cable
Calibration window is displayed.

. . . continued on next page
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Table 6-26: Procedure to Test Cabling Calibration using Communication System Analyzer

n ActionStep

2 Enter one or more channel numbers in the Channels box.

NOTE
Multiple channel numbers must be separated by a comma with no spaces (for example: 200,800).
When two or more channel numbers are entered, the cables will be calibrated for each channel.
Interpolation will be accomplished for other channels, as required, for TX calibration.

3 Select TX and RX CABLE CAL, TX CABLE CAL or RX CABLE CAL in the Cable
Calibration picklist.

4 Click OK, and follow the directions displayed for each step. A status report window will be
displayed with the results of the cable calibration.

 

Calibrate Test Cabling Using
Signal Generator & Spectrum
Analyzer

Refer to Figure 6-21 and follow the procedure in Table 6-27 to calibrate
the TX test cable configuration for all BTSs or the RX ATP test cable
configuration for BTSs with duplexed TX/RX using the signal generator
and spectrum analyzer. Refer to Figure 6-22 and follow the procedure in
Table 6-28 to calibrate the test cable configuration for  non–duplexed RX
using the signal generator and spectrum analyzer.

Table 6-27: Procedure to Calibrate TX/Duplexed RX Test Cabling Using 
Signal Generator & Spectrum Analyzer

Step Action

1 Connect a short test cable between the spectrum analyzer and the signal generator as shown in
Figure 6-21, detail “A” (top portion of figure).

2 Set signal generator to 0 dBm at the customer frequency of:

869–894 MHz or 1930–1990 MHz

3 Use spectrum analyzer to measure signal generator output (see Figure 6-21, A) and  record the value.

4 Connect the spectrum analyzer’s short cable to point B, (as shown in the lower right portion of the
diagram) to measure cable output at customer frequency of:

869–894 MHz or 1930–1990 MHz

Record the value at point B.

5 Calibration factor = (value measured with detail “A” setup) – (value measured with detail “B” setup)

Example: Cal factor = –1 dBm – (–53.5 dBm) = 52.5 dB

NOTE
The short cable is used for calibration only. It is not part of the final test setup. After calibration is
completed, do not re-arrange any cables. Use the test cable configuration as is to ensure test
procedures use the correct calibration factor.

 

6



Test Set Calibration  – continued

 6-72 1X SC480 BTS Hardware Installation, Optimization/ATP, and FRU MAY 2004

PRELIMINARY

Figure 6-21: Cal Setup for TX/Duplexed RX Test Cabling 
Using Signal Generator & Spectrum Analyzer
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Table 6-28: Procedure for Calibrating Non–Duplexed RX Test Cabling Using 
Signal Generator & Spectrum Analyzer

Step Action

NOTE
When preparing to calibrate a BTS with Duplexed TX and RX the RX cable calibration must be done
using calibration setup in Figure 6-21 and the procedure in Table 6-27.

1 Connect a short test cable between the spectrum analyzer and the signal generator as shown in
Figure 6-22, detail “A” (top portion of figure).

2 Set signal generator to –10 dBm at the customer’s RX frequency of:

824–849 for North American Cellular or 1850–1910 MHz band for North American PCS

3 Use spectrum analyzer to measure signal generator output (see Figure 6-22, A) and record the value.

4 Connect the test setup, as shown in the lower portion of the diagram (see Figure 6-22, B) to measure
the output at the customer’s RX frequency of:

824–849 for North American Cellular or 1850–1910 MHz band for North American PCS

Record the value at point B.

5 Calibration factor = (value measured with detail “A” setup) – (value measured with detail “B” setup)
Example: Cal factor = –12 dBm – (–14 dBm) = 2 dB

NOTE
The short test cable is used for test equipment setup calibration only. It is not part of the final test
setup. After calibration is completed, do not re-arrange any cables. Use the test cable configuration
as–is to ensure test procedures use the correct calibration factor.
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Figure 6-22:  Cal Setup for Non–Duplexed RX Test Cabling Using Signal Generator & Spectrum Analyzer
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Setting Cable Loss Values
Cable loss values for TX and RX test cable configurations are normally
set by accomplishing automatic cable calibration using the WinLMF and
the applicable test equipment. The WinLMF stores the measured loss
values in the cable loss files. The cable loss values can also be set or
changed manually. Follow the procedure in Table 6-29 to set cable loss
values.

CAUTION If cable calibration was performed without using the WinLMF,
cable loss values must be manually entered in the WinLMF
database. Failure to do this will result in inaccurate BTS
calibration and reduced site performance.

Prerequisites

S WinLMF is logged into the BTS

Table 6-29: Procedure for Setting Cable Loss Values

Step Action

1 Click Util in the BTS menu bar, and select Edit > Cable Loss in the pull–down menus.

– A tabbed data entry pop–up window will appear.

2 Click on the TX Cable Loss tab or the RX Cable Loss tab, as required.

3 To add a new channel number, perform the following:

3a – Click on the Add Row button.

3b – Click in the Channel # or Loss (dBm) column, as required.

3c – Enter the desired value.

. . . continued on next page
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Table 6-29: Procedure for Setting Cable Loss Values

Step Action

4 To edit existing values, click in the data box to be changed and change the value.

5 To delete a row, click on the row and then click on the Delete Row button.

6 For each tab with changes, click on the Save button to save displayed values.

7 Click on the Dismiss button to close the window.

NOTE
S Values entered or changed after the Save button was used will be lost when the window is

dismissed.

S If cable loss values exist for two different channels the WinLMF will interpolate for all other
channels.

S Entered values will be used by the WinLMF as soon as they are saved. It is not necessary to log out
and log back into the WinLMF for changes to take effect.

 

Setting TX and RX Directional
Coupler Loss Value

If an in–service TX or RX directional coupler is installed in the RF path,
the loss due to the added coupler (e.g., 30 dB) must be manually entered
so it will be included in the WinLMF TX calibration and audit
calculations and the RX FER test. Follow the procedure in Table 6-30 to
enter directional coupler loss values.

Prerequisites

S WinLMF is logged into the BTS

S Path loss, in dB, of the TX coupler must be known.

Table 6-30: Procedure for Setting TX and RX Directional Coupler Loss Values

Step Action

1 Click Util in the BTS menu bar, and select Edit > Coupler Loss... in the pull–down menus.

– A tabbed data entry pop–up window will appear.

2 Click on the TX Coupler Loss tab or the RX Coupler Loss tab, as required

3 Click in the Loss (dBm) column for each carrier that has a coupler and enter the appropriate value.

4 To edit existing values, click in the data box to be changed and change the value.

5 For each tab with changes, click on the Save button to save displayed values.

. . . continued on next page
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Table 6-30: Procedure for Setting TX and RX Directional Coupler Loss Values

Step Action

6 Click on the Dismiss button to close the window.

NOTE
S Values entered or changed after the Save button is used will be lost when the window is dismissed.

S The In–Service Calibration check box in the Tools > Options > BTS Options tab must be
checked before entered TX coupler loss values will be used by the TX calibration and audit
functions.

S New or changed values will be used by the LMF as soon as they are saved. Logging out and logging
in again are not required to cause saved changes to take effect.
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Purpose of Bay Level Offset
Calibration

Bay Level Offset (BLO) calibration is the central activity of the
optimization process. BLO calibration compensates for normal
equipment variations within the BTS RF paths and assures the correct
transmit power is available at the BTS antenna connectors to meet site
performance requirements.

What is BLO Calibration?

Description

BLO calibration is the complete title of what is normally referred to as
“calibration.” Calibration identifies the accumulated gain in every
transmit path at the BTS site. The transmit path BLO values determined
during calibration are stored in the LMF calibration data file, and are
subsequently downloaded to each BBX. When transmit path calibration
is performed, receive path BLO values will automatically be set to the
default value in the LMF calibration file and downloaded.

Component Verification During
Calibration

TX Path Calibration

TX path calibration supports verification of correct BTS installation, RF
cabling installation and performance, functionality of all equipment
installed in the transmit RF chain, and the proper functioning of each
transmit RF path. External test equipment is used to calibrate and audit
the TX paths of the BTS.

RX Path Calibration

RX path calibration is not required or supported on CDMA BTS
systems. Default RX calibration values are written to the RX calibration
data files during the TX calibration process. RX functionality is verified
during Frame Erasure Rate (FER) testing.

When to Calibrate BLOs
Calibration to determine BLO:

1. Is required after initial BTS installation.

2. Must be done once each year for an operational BTS site.

3. Is recommended by Motorola for all associated RF paths after
replacing any of the following components:

– BBX card

– CCP2 shelf

– cCLPA
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BLO Calibration Data File

During the calibration process, the LMF creates a calibration (CAL) data
file where BLO values are stored. After calibration has been completed,
these offset values must be downloaded to the BBXs using the LMF
BLO download function. A detailed description of the file organization
and content is provided in the following paragraphs

NOTE Due to the size of the file, Motorola recommends printing out a
copy of a bts–#.cal file and referring to it for the following
descriptions.

S When referring to the CAL file print–out it can be seen that there is
one BBX slot with 20 “calibration entries” per BBX (sector) for each
branch. Two calibration entries define a single “calibration point;”
therefore there are ten  calibration points in each branch for each BBX.

– The first entry for a calibration point (all odd entries) identifies the
CDMA channel (frequency) where the BLO is measured. The
second calibration entry (all even entries) is the power set level
(PwrLvlAdj) for that frequency. The valid range for PwrLvlAdj is
from 2500 to 27500 (2500 corresponds to –125 dBm and 27500
corresponds to +125 dBm).

– The ten calibration points for each slot–branch combination must be
stored in order of increasing frequency. If less than ten points
(frequencies) are calibrated, the BLO data for the highest frequency
calibrated is written into the remainder of the ten points for that
slot–branch.

Example:

C[1]=384     (odd cal entry)

C[2]=19102     (even cal entry)

C[3]=777     (odd cal entry)

C[4]=19086     (even cal entry)

C[19]=777     (odd cal entry)

C[20]=19086     (even cal entry)

.

.

.

=  1 “calibration point”

=  1 “calibration point”

=  1 “calibration point”

In the example above, BLO was measured at only two frequencies
(channels 384 and 777) for CCP2 slot BBX–1 transmit. The BLO data
for the highest frequency measured (channel 777) will be written to
the remaining eight transmit calibration points (defined by entries
C[5] through C[20]) for BBX–1.

Slot Block Temperature Compensation – Each BBX slot Block also
has a temperature compensation data section (TempLevelCal) where
power level compensation factors for temperature variations are stored.
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CAL File and BLO Data Download

When BLO data is downloaded to the BBXs after calibration, the data is
downloaded to the devices in the order it is stored in the CAL file. TX
calibration data (entries C[1] – C[60]) are sent first. Data for the ten
BBX slot 1 calibration points (entries C[1] – C[20]) are sent initially,
followed by data for the ten BBX slot 2 calibration points (entries C[21]
– C[40]), and so on. The RX calibration data is sent next in BBX slot
sequence, followed by RX Diversity calibration data.

BLO for Expansion BTS

The BLO Ranges for expansion BTS configurations are listed below:

Low Power

S 1 to 4 carriers: –13 � 7 dB

S 5 to 8 carriers: –17 � 7dB

High Power  (1 or 2 cCLPAs)

S 1 to 4 carriers: 45� 7 dB

S 5 to 8 carriers:  41 � 7dB

Test Equipment Setup for
RF Path Calibration

Follow the procedure in Table 6-31 and refer as needed to Figure 6-14 or
Figure 6-15 to set up test equipment.

Table 6-31: Procedure to Set Up Test Equipment for RF Path Calibration

Step Action

1 If it has not already been done, refer to the procedure in Table 6-6 (on page 6-17) to interface the LMF
computer terminal to the frame LAN A connector.

2 If it has not already been done, refer to Table 6-7 (on page 6-25) to start a GUI LMF session.

3 If not already done, select test equipment per the procedure in Table 6-23 or Table 6-24.

4 If required, calibrate the test equipment per the procedure in Table 6-25.

! CAUTION
To prevent damage to the test equipment in high power configurations, all transmit (TX) test
connections must be via the 30 dB directional coupler for 800 MHz.

Attenuators are not required for low power configuration.

5 For TX path calibration, connect the test equipment as shown in Figure 6-14, Figure 6-15, or
Figure 6-16, depending on the communications analyzer being used.
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Transmit (TX) Path Calibration
Description

The assigned channel frequency and desired power level at the frame TX
ports for transmit calibration are derived from the BTS CDF file. Each
BBX at the site is assigned to a carrier. These are specified respectively
in the carrier field of the ParentCARRIER parameter in each BBXs CDF
file block. The channel frequency for the assigned sector  is specified in
the ChannelList  parameter of the CDF block for the CARRIER to
which the BBX is assigned.

For Low Power optimization of the SC480, the following adjustments
must be made to the CDF.

S In the Carrier section of the CDF, verify that the SifPilotPwr is set to
–200.

S In the BTS section of the CDF, verify that the CageConf is set to 5
(CCP2), and that BIOType is set to 3.

Be sure the bts–#.cdf and cbsc–#.cdf files loaded on the
LMF computer are current. The LMF will obtain carrier
and channel information from these files and insert it into
the appropriate CDMA Test Parameter screen. Failure to
have the most current files from the CBSC can result in
incorrect channel information being used to calibrate the
BTS and unfavorable affects on BTS performance. Carrier
and channel numbers should only be entered manually for
special test cases or as a last resort.

NOTE

The calibration process attempts to adjust the measured power to within
+0.5 dB of the desired power. The calibration will pass if the error is less
than +1.5 dB.

Table 6-32 lists the maximum and minimum power with and without the
cCLPA.  The numbers presented may change at a later date.

Table 6-32: Maximum and Minimum Power

TX Configuration Max Power Min Power

Indoor / Low Power –6.0 dBm –16.0 dBm

Outdoor / Low Power –6.0 dBm –16.0 dBm

Indoor / High Power 43.0 dBm / 41.76 dBm* 33.0 dBm

Outdoor / High Power 43.0 dBm / 41.76 dBm* 33.0 dBm

* Non–domestic maximum high power is 41.76 due to TX GSM Elimination filter.
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TX Calibration and the LMF

The LMF Tests > TX > TX Calibration... and Tests > All Cal/Audit...
selections perform TX BLO calibration testing for installed BBX(s). The
All Cal/Audit... selection initiates a series of actions to perform TX
calibration, and if calibration is successful, download BLO and perform
TX audit. The TX Calibration... selection performs only TX
calibration. When TX Calibration... is used, BLO download and TX
audit must be performed as separate activities. The CDMA Test
Parameters window which opens when TX Calibration... or All
Cal/Audit... is selected contains several user–selectable features which
are described in the following subsections.

Rate Set Drop–down Pick List

The Rate Set Drop–down Box is enabled if at least one MCC card is
selected for the test. The available options for TX tests are 1 = 9600, and
3 = 9600 1X. Option 3 is only available if 1X cards are selected for the
test. The available transfer rate options for RX tests are 1 = 9600 and
2 = 14400. Option 2 is only available if no 1X cards are selected.

Verify BLO Check Box

In both the TX Calibration and All Cal/Audit dialog boxes, a Verify
BLO check box is provided and checked by default. After the actual TX
calibration is completed during either the TX Calibration or All
Cal/Audit process, the BLO derived from the calibration is compared to
a standard, acceptable BLO tolerance for the BTS. In some installations,
additional items may be installed in the transmit path. The additional
change in gain from these items could cause BLO verification failure
and, therefore, failure of the entire calibration. In these cases, either the
Verify BLO check box should be unchecked or the additional path
losses should be added.

Single–Sided BLO Check Box

An acceptable range of BLO values for each type of BTS is established
to allow for tolerance variations in all the components of the RF chain.
This acceptable range, 42+5 dB for example, is a much wider tolerance
than necessary for the BBXs. Single–Sided BLO calibration restricts the
allowable BLO variations to the lower half of the range (i.e., 37 to 42
dB). Because this is a much more stringent tolerance, calibrations run
with Single–Sided BLO are more likely to fail and should only be
attempted by an experienced CFE.

The Tests > TX > TX Calibration... menu window has a Test Pattern
pull–down menu. This menu has the following choices:

S Standard – performs calibration or audit using pilot, paging, synch,
and six traffic channels with IS–97–specified gain. This pattern setting
should be used for all non–in–service calibrations and audits. Using
this pattern setting requires the selection of both a BBX and at least
one MCC.

S Pilot (default) – performs calibration using only the pilot channel.
This pattern setting should be used for in–service calibrations, and
requires selection of only a BBX.
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S CDFPilot – This pattern setting is for advanced users. It performs
calibration or audit using the CDF value for pilot gain and IS–97 gain
values for all the other channels included in the Standard pattern
setting (paging, synch, and six traffic). Using this pattern setting
requires the selection of both a BBX and at least one MCC.

S CDF – This pattern setting is for advanced users who need to use
CDF gain settings for all channels included in the Standard pattern
setting (pilot, paging, synch, and six traffic). Using this pattern setting
requires the selection of both a BBX and at least one MCC.

Test Pattern Channels and Gain Settings – The CDMA channels and
their respective digital gain settings used for each test pattern are listed
in Table 6-33.

Table 6-33: Test Patterns with Channels and Gain Settings Used

Test Pattern Channel(s) Gain Setting

Pilot Pilot channel only 262

Standard Pilot 117

Synch channel (SCH) 57

Paging (PCH) 114

Traffic (TCH) 80 for each of 6 Walsh codes used (6*80)

CDF Pilot Pilot Uses CDF–specified pilot gain

SCH 57

PCH 114

TCH 6*80

CDF Pilot All channels use CDF–specified gains

SCH

PCH

TCH (6)

Set-up for TX Calibration

The work–around in Table 6-34 allows the user to manually set the BLO
limits .
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Table 6-34: Procedure for Initial Set-up for TX Calibration

n Step Action

1 Delete the existing calibration file (if any) from the BTS folder on LMF laptop from the location
C:\wlmf\cdma\bts–#, where # is the BTS number.

2 To edit the nominal TX BLO, from the Util menu, select Edit > TX Nominal Offset.  In the TX
Cal Parameter window, make any necessary changes to ensure the TX BLO Nominal Offset (in
dB) is set to the following:

– For 800 MHz, TX Nominal Offset value is 40.0 (dB), and the Allowed error range, plus or
minus (in dB) is 1.5

3 Download the data, which includes BLO values, to all the BBXs. From the Device menu, select  Down-
load > Data

 

TX Calibration

Before installing any test equipment directly to any BTS
TX OUT connector, first verify no CDMA channels are
keyed. Failure to do so can result in serious personal injury
and/or equipment damage.

WARNING

Always wear an approved anti–static wrist strap while
handling any circuit card or module. If this is not done,
there is a high probability that the card or module could be
damaged by ESD.

CAUTION

At new site installations, to facilitate the complete test of
the CCP2 Shelf empty BBX slots may be populated to
ensure that all BBX TX paths are tested.
This procedure can be bypassed on operational sites that
are due for periodic optimization.
Prior to testing, view the CDF (or NECF) file to verify the
correct BBX slots are equipped. Edit the file as required to
include BBX slots not currently equipped (per Systems
Engineering documentation).

NOTE

All Cal/Audit and TX
Calibration  Procedure

The LMF All Cal/Audit and TX calibration procedures are essentially
identical, except for the step that selects the type of procedure desired
(Refer to Step 4 in Table 6-35).
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Prerequisites

Before running this procedure, be sure that the following have been
done:

S The card in slot CSA, GLI, MCCs, and BBXs have correct code and
data loads.

S All BBXs are OOS_RAM (yellow).

S If running calibration or audit using a test pattern other than Pilot,
MCCs are INS_ACT (bright green).

S Test equipment and test cables are calibrated and connected for TX
calibration.

S LMF is logged into the BTS in the GUI environment.

Verify all BBX cards removed and repositioned have been
returned to their assigned shelves/slots. Any BBX cards
moved since they were downloaded will have to be
downloaded again.

NOTE

Follow the procedure in Table 6-35 to perform BLO calibration on the
TX paths, download BLO values to the BBXs, and perform TX path
audit in one operation.

Table 6-35: Procedure for All Cal/Audit and TX Calibration

Step Action

1 If it has not already been done, configure test equipment for TX calibration by following the
procedure in Table 6-31.

2 Click on the BBX(s) to be calibrated.

3 If the Test Pattern to be used is Standard, CDFPilot, or CDF, select at least one MCC (refer to “Test
Pattern Drop–down Pick List” under “TX Calibration and the LMF” in this section).

4 For All Cal Audit...

– Click Tests in the BTS menu bar, and select TX > All Cal/Audit... from the pull–down menus.
A CDMA Test Parameters window will appear.

For TX Calibration

– Click Tests in the BTS menu bar, and select TX > TX Calibration from the pull–down menus.
A CDMA Test Parameters window will appear.

5 Select the appropriate carrier(s) and sector(s) (carrier-bts#-sector#-carrier#) from those displayed in the
Channels/Carrier pick list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while clicking on pick list items to select
multiple carrier(s)–sector(s).

6 Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box.  If it is not, obtain the latest bts–#.cdf (or bts–#.necf) and cbsc–#.cdf files from the CBSC.

. . . continued on next page
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Table 6-35: Procedure for All Cal/Audit and TX Calibration

Step Action

NOTE
If necessary, the correct channel number may be manually entered into the Carrier # Channels box.

7 If at least one MCC was selected in Step 3, select the appropriate transfer rate (1 = 9600, 3 = 9600 1X)
from the drop–down list in the Rate Set box.

NOTE
The rate selection of 3 is only available if 1X cards are selected for the test.

8 If Verify BLO is to be used during the calibration, leave the checkbox checked (default).

9 If Single–Sided BLO is to be used during the calibration, click on the checkbox.

10 In the Test Pattern box, select the test pattern to use for the calibration from the drop–down list (refer
to “Test Pattern Drop–down Pick List” under “TX Calibration and the LMF” in this section).

11 Click OK to display the status report window followed by a Directions pop-up window.

12 Follow cable connection directions as they are displayed.

– When the calibration process is completed, results will be displayed in the status report window.

13 Click OK to close the status report window.

 

Exception Handling

In the event of a failure, the calibration procedure displays a FAIL
message in the status report window and provides information in the
Description field.

Re–check the test setup and connection and re–run the calibration. If the
calibration fails again, note specifics about the failure.

Download BLO Procedure

After a successful TX path calibration, download the BLO calibration
file data to the BBXs. BLO data is extracted from the CAL file for the
BTS and downloaded to the selected BBX devices.

If a successful All Cal/Audit was completed, this
procedure does not need to be performed, as BLO is
downloaded as part of the All Cal/Audit.

NOTE

Prerequisites

Ensure the following prerequisites have been met before proceeding.

S BBXs to receive the download are OOS_RAM (yellow).

S TX calibration was successfully completed
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Follow the steps in Table 6-36 to download the BLO data to the BBXs.

Table 6-36: Procedure to Download BLO

n Step Action

1 Select the BBX(s) to be downloaded.

2 Click Device in the BTS menu bar, and select Download > BLO from the pull–down menus. A
status report window displays the result of the download.

NOTE
Selected device(s) do not change color when BLO is downloaded.

3 Click OK to close the status report window.

Calibration Audit Introduction

The BLO calibration audit procedure confirms the successful generation
and storage of the BLO calibration values. The calibration audit
procedure measures the path gain or loss of every BBX transmit path at
the site. In this test, actual system tolerances are used to determine the
success or failure of a test. The same external test equipment set–up
required for TX calibration is used for TX audit.

RF path verification, BLO calibration, and BLO data
download to BBXs must have been successfully completed
prior to performing the calibration audit.

NOTE

TX Path Audit

Perform the calibration audit of the TX paths of all equipped BBX slots,
per the steps in Table 6-37.

Before installing any test equipment directly to any TX
OUT connector, first verify there are no CDMA BBX
channels keyed. Failure to do so can result in serious
personal injury and/or equipment damage.

WARNING

If a successful All Cal/Audit was completed, this
procedure does not need to be performed, as BLO is
downloaded as part of the All Cal/Audit.

NOTE

TX Audit Test

The Tests menu item, TX Audit, performs the TX BLO Audit test for
BBXs. All measurements are made through the appropriate TX output
connector using the TX calibration setup.
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Prerequisites

Before running this test, the following should be done:

S The CSA, GLIs, BBXs have correct code load.

S The CSA and GLI are INS_ACT (bright green).

S All BBXs are OOS_RAM (yellow).

S Test equipment and test cables are calibrated and connected for TX
BLO calibration.

S LMF is logged into the BTS.

TX Path Audit procedure

After a TX calibration has been performed, or if verification of BLO data
in the CAL file is required, follow the procedure in Table 6-37 to
perform a BTS TX path audit.

Table 6-37: Procedure for BTS TX Path Audit

n Step Action

1 If it has not already been done, configure test equipment for TX path audit by following the procedure
in Table 6-31 (TX audit uses the same configuration as TX calibration).

2 Select the BBX(s) to be audited.

3 If the Test Pattern to be used is Standard, CDFPilot, or CDF, select at least one MCC (refer to
“Test Pattern Drop–down Pick List” under “TX Calibraton and the LMF” in this section).

4 Click Tests in the BTS menu bar, and select TX > TX Audit... from the pull–down menus.  A
CDMA Test Parameters window will appear.

5 Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) from those displayed in the
Channels/Carrier pick list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while clicking on pick list items to
select multiple carrier(s)–sector(s).

6 Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box.  If it is not, obtain the latest bts–#.cdf (or bts–#.necf) and cbsc–#.cdf files from the CBSC.

NOTE
If necessary, the correct channel number may be manually entered into the Carrier # Channels
box.

7 If at least one MCC was selected in Step 3, select the appropriate transfer rate (1 = 9600, 3 = 9600
1X) from the drop–down list in the Rate Set box.

NOTE
The rate selection of 3 is only available if 1X cards are selected for the test.

. . . continued on next page
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Table 6-37: Procedure for BTS TX Path Audit

n ActionStep

8 From the Test Pattern pick list, select a test pattern.

– Selecting Pilot (default) performs tests using a pilot signal only.

– Selecting Standard performs tests using pilot, synch, paging and six traffic channels. This
requires an MCC to be selected.

– Selecting CDFPilot performs tests using the CDF value for pilot gain and IS–97 gain values
for all the other channels included in the Standard pattern setting (paging, synch, and six
traffic). Using this pattern setting requires the selection of both a BBX and at least one MCC.

– Selecting CDF performs tests using pilot, synch, paging and six traffic channels, however, the
gain for the channel elements is specified in the CDF file.

9 Click OK to display the status report window followed by a Directions pop-up window.

10 Follow the cable connection directions as they are displayed.  When the calibration process is
completed, results will be displayed in the status report window.

11 Click on the Save Results or Dismiss button, as desired, to close the status report window.

 

Exception Handling

In the event of a failure, the calibration procedure displays a FAIL
message in the status report window and provides information in the
Description field.

Create CAL File

The LMF Create CAL File function gets the BLO data from BBXs and
creates or updates the CAL file for the BTS. After a BTS has been fully
optimized a copy of the CAL file must exist so it can be transferred to
the CBSC. If TX calibration has been successfully performed for all
BBXs and BLO data has been downloaded, the BLO data must be saved
to the CAL file in the BTS folder.  If this is a first time calibration and
no CAL file is stored in the BTS folder, the procedure in Table 6-38 will
create the file and store the BLO data in it. If the CAl file already exists,
this procedure will update it with the new BLO data. Note the following:

S The Create Cal File function only applies to selected (highlighted)
BBXs.

Editing the CAL file is not encouraged as this action can
cause interface problems between the BTS and the LMF.
To manually edit the CAL file you must first logout of the
BTS. If you manually edit the CAL file and then use the
Create Cal File function the edited information will be lost.

CAUTION

Prerequisites

Before running the procedure in Table 6-38, the following should be
done:
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S LMF is logged into the BTS

S BBXs are OOS_RAM (yellow)

S BLO has been downloaded to the BBXs

Table 6-38: Create CAL File

Step Action

1 Select the applicable BBXs.

– The CAL file will be updated for the selected BBXs only.

2 Click on Device in the BTS menu bar, and select Create Cal File from the pull–down menu.

– A status report window will appear and display the results of the action.

3 Click the OK button to close the status report window.
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Chapter 7: Automated Acceptance Test Procedure (ATP)
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Introduction

General

The Acceptance Test Procedures (ATP) allow Cellular Field Engineers
(CFEs) to run automated acceptance tests on all BTS subsystem devices
equipped in the CDF using the LMF and the test equipment it supports.

Test Reports

The CFE can choose to save the results of ATP tests to a report file from
which ATP reports are generated for later printing. See the Generating an
ATP Report section in this chapter.

Test Equipment Selection

Because test equipment functions during acceptance testing are
controlled by the LMF through the GPIB, only the test equipment
models supported by the LMF can be used.

1. Before using the LMF, read the Developer Release
Notes section in the LMF Help function on–line
documentation for any applicable information.

2. The ATP test is to be performed on out-of-service
sectors only.

3. DO NOT substitute test equipment with other models
not supported by the LMF.

IMPORTANT
*

Test Equipment Set Calibration

Refer to Chapter 3 for detailed interconnection information needed for
calibrating equipment, cables, and other test equipment set components.

Reduced ATP

Equipment has been factory–tested for FCC compliance. If
license–governing bodies require documentation
supporting BTS site compliance with regulations, a full
ATP may be necessary. Perform the Reduced ATP only if
reports for the specific BTS site are NOT required.

NOTE

After downloading the proper operational software to the BTS, the CFE
must perform these procedures (minimum recommendation):

1. Verify the TX/RX paths by performing TX Calibration, TX Audit,
and FER tests.
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2. Retrieve Calibration Data required for normal site operation.

In the unlikely event that the BTS passes these tests but has a forward
link problem during normal operation, the CFE should then perform the
additional TX tests for troubleshooting:  TX spectral mask, TX rho, and
TX code domain.

ATP Test Options

ATP tests can be run individually or as one of the following groups:

S All TX: TX tests verify the performance of the BTS transmit
elements. These include the GLI, MCC, BBX, trunking modules, the
LPAs, and passive components including splitters, combiners,
bandpass filter(s), and RF cables.

S All RX: The RX test verifies the performance of the BTS receive
elements. These include the MPC, EMPC (for companion frames),
BBX, MCC, GLI modules, and the passive components including RX
filters and RF cables.

S All TX/RX: Executes all TX and RX tests.

S Full Optimization: Executes the TX calibration, downloads BLO,
and executes the TX audit before running all TX and RX tests.

ATP Prerequisites

Before attempting to run any ATP tests, be sure the following have been
completed:

S BTS has been optimized (BBXs calibrated and BLOs downloaded)
(Chapter 3)

S The carrier(s) and/or sector(s) to be tested have been taken out of
service at the CBSC.

S LMF is logged into the BTS

S CSA, GLI, BBXs, and MCC have correct code and data loads

S The CSA and GLI are INS_ACT (bright green)

S MCCs are INS_ACT (bright green)

S BBXs are OOS_RAM (yellow)

S Test cables are calibrated

S Test equipment has been selected, warmed up 60 minutes, and
calibrated

S GPIB is on

S No BBXs are keyed (transmitting)

S BTS transmit connectors are properly terminated for the test(s) to be
performed
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1. All transmit connectors must be properly terminated
for all ATP tests.

2. Before the FER is run, be sure that one of the
following is done:

– All transmitter connectors are properly terminated
OR

– The Compact PA is turned OFF (circuit breakers
pulled)

Failure to observe these warnings may result in bodily
injury or equipment damage.

WARNING

EV–DO Optimization and ATP

Appendix A contains procedures for testing the DO card using the LMF.
The procedures are unproven at this time. To load the DO card, the Local
Maintenance Tool (LMT) must be used. For further information on the
LMT refer to the following manuals:

S LMT Command References – 68P09258A03

S LMT Operator’s Guide – 68P09258A04

There are ATP tests available specifically for DO. For further
information refer to the following manual:

S 1xEV–DO System ATP – 68P09258A02
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Required Test Equipment

The following test equipment is required:

S LMF

S Power meter (used with HP438 and Agilent 8935)

S Communications system analyzer

S Signal generator for FER testing (required for all communications
system analyzers for 1X FER)

Before installing any test equipment directly to any BTS
TX OUT connector, verify that there are no CDMA
channels keyed.

At active sites, have the OMCR/CBSC place the carrier
assigned to the cCLPAs under test OOS. Failure to do so
can result in serious personal injury and/or equipment
damage.

WARNING

The test equipment must be re–calibrated before using it to
perform the TX Acceptance Tests.

NOTE

Acceptance Test Equipment
Set Up

All ATP testing – Follow the steps in Table 7-1 to set up test equipment
for all tests.

Table 7-1: Set Up Test Equipment – TX Output Verify/Control Tests

Step Action

1 If it has not already been done, interface the LMF computer to the BTS (refer to Table 6-6 and
Figure 6-3).

2 If it has not already been done, refer to Table 6-7 to start a GUI LMF session and log into the BTS.

3 If it has not already been done, refer to Figure 6-17, Figure 6-18, Figure 6-19, or Figure 6-20,
applicable, for the test equipment and antennas being used, to connect test equipment for acceptance
testing.

* IMPORTANT
LMF–based measurements factor in TX test cable loss between the BTS and test equipment. If
additional attenuation, such as external TX combiners, is inserted in the path, it must be identified to
the LMF by including it in the TX test cable calibration. If this is not possible, include the attenuation
in the TX path by editing cable loss values (refer to Table 6-29). Failure to do this will result in test
inaccuracies and potential for erroneous ATP failures  because the additional losses would not be
compensated for in the test measurements.
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All–inclusive Tests

General – The all–inclusive acceptance tests are performed from the
LMF GUI environment. These all–inclusive tests are called abbreviated
ATPs because they execute various combinations of individual
acceptance tests with a single command. This allows verification of
multiple aspects of BTS performance while minimizing time needed for
individual test set up and initiation.

Abbreviated ATP Options – There are three abbreviated acceptance
tests which evaluate different performance aspects of the BTS. This
allows the CFE to select testing to meet the specific requirements for
individual maintenance and performance verification situations. The
following summarizes the coverage of each abbreviated test:

S All TX/RX. Performs all transmit and receive ATPs on the selected
MCCs and BBXs.

S All TX. Performs complete set of transmit ATPs on the selected
MCCs and BBXs. Testing is the equivalent of performing all of the
following individual tests:

– TX Mask Test

– Rho Test

– Pilot Time Offset Test

– Code Domain Power Test

S All RX. Performs complete receive ATP on the selected MCCs and
BBXs. Testing is the equivalent of performing the following:

– FER Test

Abbreviated ATP Procedures – Procedures to accomplish each type of
abbreviated ATP are included in the following subsections. 7
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All TX/RX ATP Test
Follow the procedures in Table 7-2 to perform the abbreviated,
all–inclusive transmit and receive test.

Table 7-2: All TX/RX ATP Test Procedure

Step Action

1 Set up the test equipment initially for abbreviated tests as described in Table 7-1.

* IMPORTANT
If the LMF has been logged into the BTS with a different Multi–Channel Preselector setting than the
one to be used for this test, the LMF must be logged out of the BTS and logged in again with the new
Multi–Channel Preselector setting. Using the wrong MPC setting can cause a false test failure.

2 Select the BBXs and MCCs to be tested.

3 Click on Tests in the BTS menu bar, and select All TX/RX ATP... from the pull–down menu.

4 Select the appropriate carrier(s) and sector(s) (carrier-bts#-sector#-carrier#) from those displayed in the
Channels/Carrier pick list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while clicking on pick list items to select
multiple carrier(s)–sector(s).

5 Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box.

– If it is not, obtain the latest bts–#.cdf and cbsc–#.cdf files from the CBSC.

NOTE
If necessary, the correct channel number may be manually entered into the Carrier # Channels box.

6 * IMPORTANT
If a companion frame with the inter–frame diversity RX cabling disconnected is being tested do not
select BOTH in this step. The RX main and diversity paths must be tested separately for this
configuration because each requires a different Multi–Coupler Preselector type to provide the proper
test signal gain.

Select the appropriate RX branch (BOTH, MAIN, or DIVersity) in the drop–down list.

7 In the Rate Set box, select the appropriate data rate (1=9600, 2=14400, 3=9600 1X) from the
drop–down list.

NOTE
The Rate Set selection of 3 is only available if 1X cards are selected for the test.

8 In the Test Pattern box, select the test pattern to use for the acceptance tests from the drop–down list
(refer to “Test Pattern Drop–down Pick List” under “TX Calibration and the LMF” in the Bay Level
Offset Calibration section of Chapter 6.

9 Click OK to display a status bar followed by a Directions pop-up window.

10 Follow cable connection directions as they are displayed, and click the Continue button to begin
testing.

– As the ATP process is completed, results will be displayed in the status report window.
. . . continued on next page
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Table 7-2: All TX/RX ATP Test Procedure

Step Action

11 Click the Save Results or Dismiss button.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.

 

All TX ATP Test
Follow the procedures in Table 7-3 to perform the abbreviated,
all–inclusive transmit test.

Table 7-3: All TX ATP Test Procedure

Step Action

1 Set up the test equipment for abbreviated tests per Table 7-1.

2 Select the BBXs and MCCs to be tested.

3 Click on Tests in the BTS menu bar, and select All TX ATP... from the pull–down menu.

4 Select the appropriate carrier(s) and sector(s) (carrier-bts#-sector#-carrier#) from those displayed in the
Channels/Carrier pick list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while clicking on pick list items to select
multiple carrier(s)–sector(s).

5 Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box.

– If it is not, obtain the latest bts–#.cdf and cbsc–#.cdf files from the CBSC.

NOTE
If necessary, the correct channel number may be manually entered into the Carrier # Channels box.

6 In the Test Pattern box, select the test pattern to use for the acceptance test from the drop–down list
(refer to “Test Pattern Drop–down Pick List” under “TX Calibration and the LMF” in the Bay Level
Offset Calibration section of Chapter 6.

7 Click OK to display a status bar followed by a Directions pop-up window.

8 Follow cable connection directions as they are displayed, and click the Continue button to begin
testing.

– As the ATP process is completed, results will be displayed in the status report window.

9 Click the Save Results or Dismiss button.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.

 

All RX ATP Test
Follow the procedures in Table 7-4 to perform the abbreviated,
all–inclusive receive test.
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Table 7-4: All RX ATP Test Procedure

Step Action

1 Set up the test equipment for abbreviated tests per Table 7-1.

* IMPORTANT
If the LMF has been logged into the BTS with a different Multi–Channel Preselector setting than the
one to be used for this test, the LMF must be logged out of the BTS and logged in again with the new
Multi–Channel Preselector setting. Using the wrong MPC setting can cause a false test failure.

2 Select the BBXs and MCCs to be tested.

3 Click on Tests in the BTS menu bar, and select All RX ATP... from the pull–down menu.

4 Select the appropriate carrier(s) and sector(s) (carrier-bts#-sector#-carrier#) from those displayed in the
Channels/Carrier pick list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while clicking on pick list items to select
multiple carrier(s)–sector(s).

5 Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box.

– If it is not, obtain the latest bts–#.cdf and cbsc–#.cdf files from the CBSC.

NOTE
If necessary, the correct channel number may be manually entered into the Carrier # Channels box.

6 * IMPORTANT
If a companion frame with the inter–frame diversity RX cabling disconnected is being tested do not
select BOTH in this step. The RX main and diversity paths must be tested separately for this
configuration because each requires a different Multi–Coupler Preselector type to provide the proper
test signal gain.

Select the appropriate RX branch (BOTH, MAIN, or DIVersity) in the drop–down list.

7 In the Rate Set box, select the appropriate data rate (1=9600, 2=14400, 3=9600 1X) from the
drop–down list.

NOTE
The Rate Set selection of 3 is only available if 1X cards are selected for the test.

8 Click OK to display a status bar followed by a Directions pop-up window.

9 Follow cable connection directions as they are displayed, and click the Continue button to begin
testing.

– When the ATP process is completed, results will be displayed in the status report window.

10 Click the Save Results or Dismiss button.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.
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Individual Acceptance Tests

The following individual ATP tests can be used to evaluate specific
aspects of BTS operation against individual performance requirements.
All testing is performed using the LMF GUI environment.

TX Testing

TX tests verify any given transmit antenna path and output power
control. All tests are performed using the external, calibrated test
equipment. All measurements are made at the appropriate BTS TX OUT
connector(s).

TX tests verify TX operation of the entire CDMA forward link using
selected BBXs assigned to respective sector antennas. Each BBX is
keyed up to generate a CDMA carrier (using both bbxlevel and BLO)
at the CDF file–specified carrier output power level.

RX Testing

RX testing verifies receive antenna paths for BBXs selected for the test.
All tests are performed using the external, calibrated test equipment to
inject a CDMA RF carrier with all zero longcode at the specified RX
frequency at the appropriate BTS RX IN connector(s).

RX tests verify RX operation of the entire CDMA reverse link using all
equipped MCCs assigned to all respective sector/antennas.

Individual Tests

Spectral Purity TX Mask

This test verifies that the transmitted CDMA carrier waveform generated
on each sector meets the transmit spectral mask specification (as defined
in IS–97) with respect to the assigned CDF file values.

Waveform Quality (Rho)

This test verifies that the transmitted Pilot channel element digital
waveform quality (rho) exceeds the minimum specified value in IS–97.
Rho represents the correlation between the actual and perfect CDMA
modulation spectrums. 1.0000 represents 100% (or perfect correlation).

Pilot Time Offset

The Pilot Time Offset is the difference between the communications
system test set measurement interval (based on the BTS system time
reference) and the incoming block of transmitted data from the BTS
(Pilot only, Walsh code 0).

Code Domain Power/Noise Floor

This test verifies the code domain power levels, which have been set for
all ODD numbered Walsh channels, using the OCNS command. This is
done by verifying that the ratio of PILOT divided by OCNS is equal to
10.2 + 2 dB, and, that the noise floor of all EVEN numbered “OFF”
Walsh channels measures < –27 dB for IS–95A/B and CDMA2000 1X
with respect to total CDMA channel power.
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BTS FER

This test verifies the BTS receive FER on all traffic channel elements
currently configured on all equipped MCCs (fullrate at one percent FER)
at an RF input level of –119 dBm on the main RX antenna paths using
operator–selected, CDF–equipped MCCs and BBXs at the site. Diversity
RX antenna paths are also tested using the lowest equipped MCC
channel element ONLY.

There are no pass/fail criteria associated with FER readings
taken at levels below –119 dBm, other than to verify that
the FER measurement reflects changes in the RX input
signal level.

NOTE

7
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Background

Overview – This test verifies the spectral purity of each
operator–selected BBX carrier keyed up at a specific frequency specified
in the current CDF. All tests are performed using the external, calibrated
test equipment controlled by the same command. All measurements are
made at the appropriate BTS TX antenna connector.

Test Patterns – There are four operator–selectable test patterns with
which this acceptance test can be performed. The patterns, along with the
channels tested and gain setting for each, are listed in Table 6-33. Refer
to “TX Calibration and the LMF” in the Bay Level Offset Calibration
section for more information on the test patterns.

Equipment Operation During Testing – At least one MCC must be
selected to perform the Standard, CDF Pilot, and CDF test patterns. For
these test patterns, forward links will be enabled for synch channel
(SCH), paging channel (PCH), and traffic channel (TCH) elements from
the selected MCC(s), as shown in Table 6-33. Gain will be set for the
applicable channels on each antenna as shown in the table. The
operator–selected BBXs will be keyed using a BLO–corrected bbxlvl
value to generate a CDMA carrier. RF output power, as measured at the
appropriate frame TX antenna connector, will be set to one of the
following depending on the operating frequency spectrum:

S 800 MHz:  33.5 dBm

Test Measurements – The test equipment will measure and return the
attenuation level in dB of all spurious and IM products with respect to
the mean power of the CDMA channel measured in a 1.23 MHz
bandwidth, verifying that results meet system tolerances at the following
test points (see also Figure 7-1):

S For 800 MHz:

– At least –45 dB @ + 750 kHz from center frequency

– At least –45 dB @ – 750 kHz from center frequency

– At least –60 dB @ – 1980 kHz from center frequency

– At least –60 dB @  + 1980 kHz from center frequency

Spectral Purity TX Mask
Acceptance Test

Follow the steps in Table 7-5 to verify the transmit spectral mask
specification on the TX antenna paths for the selected BBXs.

Table 7-5: Test Spectral Purity Transmit Mask

Step Action

1 Set up the test equipment for TX acceptance tests per Table 7-1.
. . . continued on next page
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Table 7-5: Test Spectral Purity Transmit Mask

Step Action

2 Select the BBXs to be tested.

3 Click on Tests in the BTS menu bar, and select TX > TX Mask... from the pull–down menus.

4 Select the appropriate carrier(s) and sector(s) (carrier-bts#-sector#-carrier#) from those displayed in the
Channels/Carrier pick list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while clicking on pick list items to select
multiple carrier(s)–sector(s).

5 Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box.

– If it is not, obtain the latest bts–#.cdf and cbsc–#.cdf files from the CBSC.

NOTE
If necessary, the correct channel number may be manually entered into the Carrier # Channels box.

6 In the Test Pattern box, select the test pattern to use for the calibration from the drop–down list (refer
to “Test Pattern Drop–down Pick List” under “TX Calibration and the LMF” in the Bay Level Offset
Calibration section.

7 Click OK to display a status  bar followed by a Directions pop-up window.

8 Follow the cable connection directions as they are displayed, and click the Continue button to begin
testing.

– As the ATP process is completed, results will be displayed in a status report window.

9 Click the Save Results or Dismiss button.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.
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Figure 7-1: TX Mask Verification Spectrum Analyzer Display
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Background

Overview – This test verifies the transmitted pilot channel element
digital waveform quality of each operator–selected BBX carrier keyed up
at a specific frequency specified in the current CDF. All tests are
performed using the external, calibrated test equipment controlled by the
same command. All measurements are made at the appropriate TX
antenna connector.

Equipment Operation During Testing – Pilot gain will be set to 262
for each antenna, and all TCH elements from the MCCs will be
forward–link disabled. The selected BBXs will be keyed up using both
bbxlvl and BLO to generate a CDMA carrier (with pilot channel
element only, Walsh code 0). RF output power is set at 40 dBm as
measured at the appropriate BTS TX antenna connector.

Test Measurements – The test equipment will measure and return the
pilot channel element digital waveform quality (rho) percentage,
verifying that the result meets the following specification:

Waveform quality (Rho) should be > 0.98.

Waveform Quality (Rho)
Acceptance Test

Follow the steps in Table 7-6 to verify the pilot channel element
waveform quality (rho) on the TX antenna paths for the selected BBXs.

Table 7-6: Test Waveform Quality (Rho)

Step Action

1 Set up the test equipment for TX acceptance tests per Table 7-1.

2 Select the BBXs to be tested.

3 Click on Tests in the BTS menu bar, and select TX > Rho... from the pull–down menus.

4 Select the appropriate carrier(s) and sector(s) (carrier-bts#-sector#-carrier#) from those displayed in the
Channels/Carrier pick list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while clicking on pick list items to select
multiple carrier(s)–sector(s).

5 Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box.

– If it is not, obtain the latest bts–#.cdf and cbsc–#.cdf files from the CBSC.

NOTE
If necessary, the correct channel number may be manually entered into the Carrier # Channels box.

6 Click OK to display a status bar followed by a Directions pop-up window.

7 Follow the cable connection directions as they are displayed, and click the Continue button to begin
testing.

– As the ATP process is completed, results will be displayed in a status report window.
. . . continued on next page
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Table 7-6: Test Waveform Quality (Rho)

Step Action

8 Click the Save Results or Dismiss button.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.
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Background

Overview – This test verifies the transmitted pilot channel element Pilot
Time Offset of each operator–selected BBX carrier keyed up at a specific
frequency specified in the current CDF. All tests will be performed using
the external, calibrated test equipment controlled by the same command.
All measurements will be made at the BTS TX antenna connector.

Equipment Operation During Testing – The pilot gain will be set to
262 for each antenna and all TCH elements from the MCCs will be
forward–link disabled. The selected BBXs will be keyed using both
bbxlvl and BLO to generate a CDMA carrier (with pilot channel
element only, Walsh code 0). TX power output is set at 40 dBm as
measured at the TX output.

Test Measurements – The test equipment will measure and return the
Pilot Time Offset in ms, verifying that results meet the following
specification:

Pilot Time Offset should be within 3 ms of the target PT Offset 
(zero ms).

This test also executes and returns the TX Frequency and
TX Waveform Quality (rho) ATP tests, however, only Pilot
Time Offset results are written to the ATP test report.

NOTE

Pilot Time Offset Acceptance
Test

Follow the steps in Table 7-7 to verify the Pilot Time Offset on the TX
antenna paths for the selected BBXs.

Table 7-7: Test Pilot Time Offset

Step Action

1 Set up the test equipment for TX acceptance tests per Table 7-1.

2 Select the BBXs to be tested.

3 Click on Tests in the BTS menu bar, and select TX > Pilot Time Offset... from the pull–down menus.

4 Select the appropriate carrier(s) and sector(s) (carrier-bts#-sector#-carrier#) from those displayed in the
Channels/Carrier pick list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while clicking on pick list items to select
multiple carrier(s)–sector(s).

. . . continued on next page
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Table 7-7: Test Pilot Time Offset

Step Action

5 Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box.

– If it is not, obtain the latest bts–#.cdf and cbsc–#.cdf files from the CBSC.

NOTE
If necessary, the correct channel number may be manually entered into the Carrier # Channels box.

6 Click OK to display a status bar followed by a Directions pop-up window.

7 Follow the cable connection directions as they are displayed, and click the Continue button to begin
testing.

– As the ATP process is completed, results will be displayed in a status report window.

8 Click the Save Results or Dismiss button.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.
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Background

Overview – This test verifies the Code Domain Power and Noise Floor
of each operator–selected BBX carrier keyed at a specific frequency
specified in the current CDF. All tests are performed using the external,
calibrated test equipment controlled by the same command. All
measurements are made at the appropriate BTS TX antenna connector.

CDMA Channel Test Set–up – Pilot gain will be set to 262 for each
antenna and the selected MCCs will be configured to supply all
odd–numbered Walsh code traffic channel elements by enabling
Orthogonal Channel Noise Source (OCNS) on all odd MCC channel
elements (maximum 32 full rate channels with an OCNS gain of 81). All
even–numbered Walsh code traffic channel elements will not have
OCNS enabled, and are considered “OFF”. Selected MCCs will be
forward–link enabled for the antenna (sector) under test.

Equipment Operation During Testing – The BBX will be keyed up
using a BLO–corrected bbxlvl value to generate a CDMA carrier
consisting of pilot and OCNS channels. RF output power, as measured at
the appropriate frame TX antenna connector, is set at one of the
following values depending on the operating frequency spectrum:

S 800 MHz:  33.5 dBm

Test Measurements – The test equipment will measure and return the
channel element power in dB of all specified Walsh channels within the
CDMA spectrum. Additional calculations will be performed to verify the
following parameters are met (refer to Figure 7-2 for graphic
representations):

S Traffic channel element power level will be verified by calculating the
ratio of Pilot power to OCNS gain of all traffic channels (root sum of
the square (RSS) of each OCNS gain divided by the Pilot power).
This value should be 10.2 dB + 2.0 dB.

S Noise floor (unassigned “OFF” even–numbered Walsh channels) is
verified to be < –27 dB for IS–95A/B and CDMA2000 1X with
respect to total CDMA channel power.

Code Domain Power/Noise
Floor Test

Follow the steps in Table 7-8 to verify the Code Domain Power/Noise
floor of each selected BBX carrier keyed up at a specific frequency.
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Table 7-8: Test Code Domain Power/Noise Floor

Step Action

1 Set up the test equipment for TX acceptance tests per Table 7-1.

2 Select the BBXs and MCCs to be tested.

3 Click on Tests in the BTS menu bar, and select TX > Code Domain Power... from the pull–down
menus.

4 Select the appropriate carrier(s) and sector(s) (carrier-bts#-sector#-carrier#) from those displayed in the
Channels/Carrier pick list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while clicking on pick list items to select
multiple carrier(s)–sector(s).

5 Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box.

– If it is not, obtain the latest bts–#.cdf and cbsc–#.cdf files from the CBSC.

NOTE
If necessary, the correct channel number may be manually entered into the Carrier # Channels box.

6 Click OK to display a status  bar followed by a Directions pop-up window.

7 Follow the cable connection directions as they are displayed, and click the Continue button to begin
testing.

– As the ATP process is completed, results will be displayed in a status report window.

8 Click the Save Results or Dismiss button.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.
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Pilot Channel

Active channels

PILOT LEVEL

MAX OCNS SPEC.

MIN OCNS SPEC.

MAXIMUM NOISE FLOOR: 
< –27 dB FOR IS–95A/B AND
CDMA2000 1X

Inactive channels

Walsh  0  1  2  3  4  5  6  7 ... 64

MAX OCNS
CHANNEL

MIN OCNS
CHANNEL

8.2 dB 12.2 dB

MAX NOISE
FLOOR

Pilot Channel

Active channels

PILOT LEVEL

MAX OCNS SPEC.

MIN OCNS SPEC.

MAXIMUM NOISE FLOOR: 
< –27 dB FOR IS–95A/B AND
CDMA2000 1X

Inactive channels

Walsh  0  1  2  3  4  5  6  7 ... 64

FAILURE – DOES NOT
MEET MIN OCNS SPEC.

FAILURE – EXCEEDS
MAX OCNS SPEC. 8.2 dB 12.2 dB

FAILURE – EXCEEDS MAX
NOISE FLOOR SPEC.

Code Domain Power/Noise Floor (OCNS Pass) Example
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Background

Overview – This test verifies the BTS Frame Erasure Rate (FER) on all
TCHs currently configured on operator–selected MCCs (fullrate at 1%
FER) at –119 dBm. All tests are performed using the external, calibrated
test equipment as the signal source controlled by the same command.
Measurements are made at the specified BTS RX antenna connection.

Equipment Operation During Testing – The pilot gain on each MCC
will be set to 262 for each TX antenna, and the forward link for all TCH
elements from the MCCs will be enabled. Appropriate BBX(s) must be
keyed in order to enable the RX receive circuitry. Operator–selected
BBXs will be keyed using only bbxlvl, to generate a CDMA carrier
with pilot channel element only. Transmit power output is set at –40
dBm. Test equipment output power is set so that the received power at
the BBX is –119 dBm. The final output power setting of the test
equipment takes into account the MPC type, BTS RF path losses, and
test cable losses. .

Test Measurements – The LMF will prompt the MCC channel element
under test to measure all–zero longcode and provide the FER report on
the selected active MCC on the reverse link for the main and, if selected,
diversity RX antenna paths. Results are evaluated to ensure they meet
the following specification:

FER returned less than 1% and Total Frames measured is 1500

FER Acceptance Test

Follow the steps in Table 7-9 to verify the FER on RX antenna paths
using selected MCCs and BBXs.

Table 7-9: Test FER

Step Action

1 Set up the test equipment for RX acceptance tests per Table 7-1.

2 * IMPORTANT
If the LMF has been logged into the BTS with a different Multi–Channel Preselector setting than the
one to be used for this test, the LMF must be logged out of the BTS and logged in again with the new
Multi–Channel Preselector setting. Using the wrong MPC setting can cause a false test failure.

3 Select the BBXs and MCCs to be tested.

4 Click on Tests in the BTS menu bar, and select RX > FER... from the pull–down menu.

5 Select the appropriate carrier(s) and sector(s) (carrier-bts#-sector#-carrier#) from those displayed in the
Channels/Carrier pick list.

6 NOTE
To select multiple items, hold down the Shift or Ctrl key while clicking on pick list items to select
multiple carrier(s)–sector(s).

. . . continued on next page
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Table 7-9: Test FER

Step Action

7 Verify that the correct channel number for the selected carrier is shown in the Carrier # Channels
box.

– If it is not, obtain the latest bts–#.cdf and cbsc–#.cdf files from the CBSC.

8 NOTE
If necessary, the correct channel number may be manually entered into the Carrier # Channels box.

9 * IMPORTANT
If a companion frame with the inter–frame diversity RX cabling disconnected is being tested do not
select BOTH in this step. The RX main and diversity paths must be tested separately for this
configuration because each requires a different Multi–Coupler Preselector type to provide the proper
test signal gain.

10 Select the appropriate RX branch (Both, Main, or Diversity) in the drop–down list.

11 In the Rate Set box, select the appropriate data rate (1=9600, 2=14400, 3=9600 1X) from the
drop–down list.

12 NOTE
The Rate Set selection of 3 is only available if 1X cards are selected for the test.

13 Click OK to display a status bar followed by a Directions pop-up window.

14 Follow cable connection directions as they are displayed, and click the Continue button to begin
testing.

– As the ATP process is completed, results will be displayed in the status report window.

15 Click the Save Results or Dismiss button.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.
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Background

Each time an ATP test is run, ATP data is updated and must be saved to
an ATP report file using the Save Results button to close the status
report window. The ATP report file will not be updated if the status
reports window is closed using the Dismiss button.

ATP Report

A separate report is created for each BTS and includes the following for
each test:

S Test name

S PASS or FAIL

S Description information (if applicable)

S BBX number

S Channel number

S Carrier number

S Sector number

S Upper test limit

S Lower test limit

S Test result

S Time stamp

S Details/Warning information (if applicable)

Follow the procedures in the Table 7-10 to view and create a printable
file for the ATP report.

Table 7-10: Generating an ATP Report

Step Action

1 Click on the Login tab (if not in the forefront).

2 Click on the desired BTS in the Available Base Stations pick list to select it.

3 Click on the Report button.

4 If a printable file is not needed, click on the Dismiss button.

5 If a printable file is required, perform the following:

5a – Select the desired file type (text, comma–delimited, HTML) for the report file from the
drop–down list at the bottom of the screen.

5b – Click the Save button to save the file.
–– The file will be saved in the selected format in the bts–# folder for the BTS selected.
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Notes
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Software Release caveats

With Software Release 2.16.1.x, the packet BTS will NOT detect a new
calibration file on the OMC–R. A manual workaround is available in
bulletin cdma_g_bts_059. This will be corrected in Software Release
2.16.3.

Software Release 2.16.3 will allow the user to load the calibration file
from the LMF directly onto the MGLI. The MGLI will then ftp the new
calibration file to the OMC–R, thereby eliminating the need for the user
to place the calibration file at the OMC–R.

Copy and Load Cal File to to
CBSC

After completing the TX calibration and audit, updated CAL file
information must be moved from the LMF Windows environment back
to the CBSC, a Unix environment. The following procedures detail
moving files from one environment to the other.

Copying CAL files from LMF to a Diskette

Follow the procedures in Table 8-1 to copy the CAL files from an LMF
computer to a 3.5 diskette.

Table 8-1: Copying CAL Files to a Diskette

Step Action

1 With Windows running on the LMF computer, insert a disk into Drive A:\.

2 Launch the Windows Explorer application program from the Start > Programs menu list.

3 Select the applicable <x>:\<lmf home directory/cdma/bts–# folder.

4 Drag the bts–#.cal file to Drive A.

5 Repeat Steps 3 and 4, as required, for other bts–# folders.
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Copying CAL Files from Diskette to the CBSC

Follow the procedures in Table 8-2 to copy CAL files from a diskette to
the CBSC.

Table 8-2: Copying CAL Files from Diskette to the CBSC

Step Action

1 Log into the CBSC on the OMC–R Unix workstation using your account name and password.

2 Place the diskette containing calibration files (cal files) in the workstation diskette drive.

3 Type in eject –q and press the Enter key.

4 Enter mount and press the Enter key.  Verify that  floppy/no_name is displayed.

NOTE
If the eject command has been previously entered, floppy/no_name will be appended with a
number.  Use the explicit floppy/no_name reference displayed.

5 Type in cd /floppy/no_name and press the Enter key.

6 Type in ls –lia and press the Enter key. Verify the bts–#.cal file filename appears in the displayed
directory listing.

7 Type in cd and press the Enter key.

8 Type in pwd and press the Enter key. Verify the displayed response shows the correct home
directory (/home/<user’s name>).

9 With Solaris versions of Unix, create a Unix–formatted version of the bts–#.cal file in the home
directory by performing the following:

9a – Type in dos2unix  /floppy/no_name/bts–#.cal  bts–#.cal and press the Enter key.

Where:  #  =  BTS number for which the CAL file was created

NOTE
Other versions of Unix do not support the dos2unix command. In these cases, use the Unix cp
(copy) command. The copied files will contain DOS line feed characters which must be edited out
with a Unix text editor.

10 Type in ls –l *.cal and press the Enter key. Verify the CAL files have been copied. Verify all CAL
files to be transferred appear in the displayed listing.

11 Type eject and press the Enter key.

12 Remove the diskette from the workstation.
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External Test Equipment
Removal

Perform the procedure in Table 8-3 to disconnect the test equipment and
configure the BTS for active service.

Table 8-3: Remove External Test Equipment

Step Action

1 n WARNING
Be sure no BBXs are keyed before performing this step. Failure to do so can result in personal injury
and damage to BTS LPAs.

Disconnect all external test equipment from all TX and RX connectors at the rear of the frame.

2 Reconnect and visually inspect all TX and RX antenna feed lines at the frame RF interface panel.

NOTE
Verify that all sector antenna feed lines are connected to the correct antenna connectors on the frame.
Crossed antenna cables will degrade call processing.

Bringing Modules into Service
with the LMF

Whenever possible, have the CBSC/MM bring up the site
and enable all devices at the BTS.

NOTE

If there is a reason code and/or data should or could not be loaded
remotely from the CBSC, follow the steps outlined in Table 8-4 as
required to bring BTS processor modules from OOS to INS state.

Table 8-4: Bring Modules into Service

Step Action

1 In the WinLMF GUI environment, select the device(s) to be enabled by clicking on each one.

NOTE
S The GLI and CSA must be INS_ACT (bright green) before an MCC can be enabled.

S Processors which must be enabled and the order of enabling are as follows:

1. GLI

2. CSA

3. MCCs

2 Click on Device in the BTS menu bar, and select Enable from the pull–down list.

– A status report window is displayed.

3 NOTE
If a BBX is selected, a transceiver parameters window is displayed to collect keying information. Do
not enable the BBX.

. . . continued on next page
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Table 8-4: Bring Modules into Service

Step Action

4 Click Cancel to close the transceiver parameters window, if applicable.

5 Click OK to close the status report window.

– The color of devices which successfully change to INS will change bright green.
 

WinLMF Removal

Perform the procedure in Table 8-5 as required to terminate the WinLMF
GUI session and remove the WinLMF computer.

Table 8-5: Terminate the WinLMF Session and Remove the WinLMF

Step Action

1 ! CAUTION
Do not power down the WinLMF terminal without performing the procedure below. Corrupted/lost
data files may result.

Log out of all BTS sessions and exit WinLMF by clicking on File in the WinLMF window menu bar and
selecting Logout and Exit from the pull–down list.

2 In the Windows Task Bar, click Start and select Shutdown. Click Yes when the Shut Down Windows
message appears.

3 Wait for the system to shut down and the screen to go blank.

4 Disconnect the WinLMF terminal Ethernet port from the BTS frame.

5 Disconnect the WinLMF terminal serial port, the RS–232–to–GPIB interface box, and the GPIB
cables as required for equipment transport.

Connecting BTS T1/E1 Spans

Perform the procedure in Table 8-6 to connect any T1 or E1 span
connectors removed previously to allow the WinLMF to control the
BTS.

Table 8-6: Connect T1 or E1 Spans

Step Action

1 Re–connect any disconnected span lines.

2 Verify span status, ensuring the OMC–R/CBSC can communicate with the BTS.
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Final Checks before leaving
site

Be sure all requirements listed in Table 8-7 are completed before leaving
the site.

Table 8-7: Check Before Leaving the Site

Step Action

1 When backup batteries are installed, all battery circuit breakers are  ON (pushed in).

2 BTS circuit breaker is ON (pushed in).

3 No alarm conditions are being reported to the OMC–R.

Reset All Devices and Initialize
Site Remotely

Devices in the BTS should not be left with data and code loaded from
the WinLMF. The configuration data and code loads used for normal
operation could be different from those stored in the WinLMF files.
Perform the procedure in Table 8-8 to reset all devices and initialize site
remotely.

Table 8-8: Reset BTS Devices and Remote Site Initialization

Step Action

1 Terminate the WinLMF session by following the procedures in Table 8-5.

2 Reconnect spans by following the procedure in Table 8-6.

3 Circuit BTS Procedure:

3a From the BTS site, contact the OMC–R and request the operator to perform a BTS reset.

or

At the BTS site:

– unseat the GLI card and wait for 30 seconds;

3b Have the operator  perform the following:

S ACTIVATE the GLI to set the Nextload attribute for the GLI to the one for the current BSS
software version;

S Disable the GLI;

S Enable the GLI to allow the MM to load the software version specified by the Nextload
attribute;

S Once the GLI is INS_ACT, contact the OMC–R and request the operator ACTIVATE the BTS.

– Once the GLI card is loaded with the specified code version, the GLI will verify and update, as
required, the RAM and, if it is necessary, ROM code loads for the installed CSA, MCC, and BBX
cards using the DLM.

4 After all activities at the site have been completed, contact the OMC–R and confirm that the BTS is
under OMC–R control.
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Scope

The objective of the Field Replaceable Unit (FRU ) section contains
OMC–R procedures and information and procedures for disassembling
and/or replacing cards, modules, and components of the Compact BTS.
The Compact BTS is a single cage, non–redundant configuration.

Section Organization

The FRU section is organized in the following manner:

S Compact BTS FRU procedures that are performed by a technician at
the site

S OMC–R procedures performed by the operator

BTS FRU Procedures

The BTS FRU procedures are grouped by major functional areas within
the BTS and presented as follows:

S Compact BTS Input/Output (CBIO) Board Replacement Procedure

– Synchronization Daisy–Chaining and eXpansion (SDCX) Module
Replacement Procedure

– RF GPS Module Replacement Procedure

S CCP2 Card and Shelf Replacement Procedures

S RF Component Replacement Procedures

S High Stability Oscillator/Medium Stability Oscillator (HSO/MSO)
Replacement Procedure

External Components – The following external components are
optional 

S Compact Combined Linear Power Amplifier (cCLPA) Replacement
Procedure

OMC–R Procedures

Describes procedures that can be performed only by the operator from
the OMC–R site.

If the OMC–R operator is unable to resolve the problem, then the user
will be directed to the appropriate section of the Troubleshooting manual
for further action.
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Figure 9-1: Compact BTS Front Panel Layout without Front Panel Cover
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Figure 9-2: Compact BTS Fan and CCP2 Shelf Layout
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Introduction

The fan module is located above the CCP2 Shelf at the front of the
Compact BTS.

The fan mdoule is a modular device allowing easy replacement. The
electrical connection for DC power is made through a connector at the
rear of the module. The connector is automatically engaged when the fan
module is inserted and seated.

System Impact/Considerations

At room temperature, the fan module is very quiet.
Operation can be verified by holding a hand over the
exhaust grill on top and feeling for air movement.

NOTE

Performing this replacement procedure will not cause
downtime or interrupt call processing, but it will trigger
alarms.

IMPORTANT

*

If a fan begins to degrade or fails, an alarm signal will be sent to the
Clock Synchronization Alarms card in the CCP2 Shelf.

Required Items

Documents

None.

Tools

None.

Replacement Units

For –48 VDC – One fan module (STLN4696)

For +27 VDC – One fan module (STLN6210)

Prerequisite

Coordinate this repair task with the OMC–R operator.

IMPORTANT

*
Contact the OMC–R operator before performing the replacement
procedure. Tell the operator that the fan module will be replaced and that
alarms can be expected.
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Upon completion of the replacement procedure, have the OMC–R
operator verify that old alarms are cleared and that no new ones are
reported.

Replacement Procedure

This procedure requires working around circuitry that is
extremely sensitive to Electrostatic Discharge (ESD). Wear
a conductive, high impedance wrist strap during the
procedure.
Use appropriate safety measures.

CAUTION

If desired, record the BTS and Fan Module serial number of the failed
unit in Table 9-53 at the end of this chapter.

Remove Fan Module

Use the procedure in Table 9-1 to remove the fan module.

Table 9-1: Procedure to Remove Fan Module

Step Action

1 Notify operator that the fan replacement procedure is starting and that alarms can be expected.

2 Put on the ESD wrist strap or another approved grounding device.

3 If not already done, remove BTS front panel cover by grasping finger grooves at the top and bottom
and pulling simultaneously.

4 Lower the latch on front of the fan module while gently pulling it forward.

5 When the fan module is half–way out, support it with the other hand and remove it the rest of the way.

  

Figure 9-3: Fan Module
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Install Fan Module

Use the procedure in Table 9-2 to install the fan module.

Table 9-2: Procedure to Install Fan Module

Step Action

1 Put on the ESD wrist strap or another approved grounding device.

2 Using both hands, set the fan module in the guide channels, and slide module in.

3 Ensure that fan module seats and front latch engages.

4 Notify operator that the fan replacement procedure is completed. Have operator verify that old alarms
have cleared and no new alarms are reported.

5 Install BTS front panel cover by setting it in place and pushing on the top and bottom simultaneously.
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Introduction

The High Stability and Medium Stability Oscillator  module provide a
backup reference source in the case of Global Positioning System (GPS)
failure. The HSO is capable of providing up to 24 hours, the
synchronization initially established by the GPS reference signal. The
MSO is capable of providing up to 8 hours.

There is only one HSO or MSO equipped in the Compact BTS. The
module is located in front, behind a cover,  underneath the CCP2 Shelf.
The HSO or MSO slides into the top slot of the two that are present.

System Impact/Considerations

The HSO or MSO produces a 1 pulse per second (1 pps) clock output
signal to the CSA.

Front Panel Indicator

The HSO or MSO have no indicators.

Required Items

Documents

None.

Tools

None.

Replacement Units

S One HSO module (SGLA4007)

S One MSO module (SGLA4008)

Prerequisite

Coordinate this replacement with the OMC–R operator.

IMPORTANT

*

Contact the OMC–R operator before performing the replacement
procedure. Tell the operator that the HSO or MSO module will be
replaced and that alarms can be expected.

Upon completion of the replacement procedure, have the OMC–R
operator verify that old alarms are cleared and that no new ones are
reported.
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Replacement Procedure

This procedure requires working around circuitry that is
extremely sensitive to Electrostatic Discharge (ESD). Wear
a conductive, high impedance wrist strap during the
procedure.
Use appropriate safety measures.

CAUTION

If desired, record the BTS and HSO/MSO serial number of the failed
unit in Table 9-54 at the end of this chapter.

Remove HSO or MSO Module

Follow the procedure in Table 9-3 to remove the HSO or MSO module.
See Figure 9-4.

Table 9-3: Procedure to Remove HSO or MSO Module

Step Action

1 Notify operator that the HSO or MSO replacement procedure is starting and that alarms can be
expected.

2 Put on an ESD wrist strap or other approved grounding device.

3 If not already done, remove BTS front panel cover  by grasping finger grooves at the top and bottom
and pulling simultaneously.

4 If not already done,  remove HSO Module cover panel by turning latch, gently pulling it open, and
sliding it out towards the right. The panel has a flange that fits into a slot in the frame.

5 Use a T20 star bit to remove two M4 screws securing HSO or MSO to frame.

6 Pull on handle to gently slide HSO or MSO out and disconnect cable from side. See Figure 9-5.

  

Install HSO or MSO

Follow the procedure in Table 9-4 to install the HSO or MSO module.

Table 9-4: Procedure to Install HSO or MSO Module

Step Action

1 Put on an ESD wrist strap or other approved grounding device.

* IMPORTANT
The HSO and MSO will only fit into the top slot. DO NOT force it into the lower slot.

2 Connect cable to side of HSO or MSO and slide into top slot.

3 Secure HSO or MSO to frame using two M4 screws. Torque screws to 2.3 N–M (20 in–lbs).

 table continued on next page
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